Thank You for Choosing Ross

You’ve made a great choice. We expect you will be very happy with your purchase of Ross Technology. Our mission is to:

1. Provide a Superior Customer Experience
   • offer the best product quality and support
2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it’s our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there’s no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)
RAPTOR-IPG · User Guide

• Ross Part Number: 8929DR-004-04
• Release Date: September 15, 2020.

The information contained in this Guide is subject to change without notice or obligation.

Copyright

©2020 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

 Patents


Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Safety Notices

Refer to the “Important Regulatory and Safety Notices” document that accompanied your product.

Statement of Compliance

This product has been determined to be compliant with the applicable standards, regulations, and directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is available upon request by contacting techsupport@rossvideo.com. Please include the product; model number identifiers and serial number and country that compliance information is needed in request.

EMC Notices

US FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Notice** — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the user's authority to operate this equipment.

**Canada**
This Class “A” digital apparatus complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appareil numérique de la classe “A” est conforme a la norme NMB-003 du Canada.

**European Union**
This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

**Warning** — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause radio interference.

**Australia/New Zealand**
This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and Radiocommunications Labeling (Electromagnetic Compatibility) Notice 2008.

**Korea**
This equipment is in compliance with the provisions established under the Radio Waves Act.
Class A equipment (Broadcasting and communications service for business use)
This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be aware of this fact. This device is intended for use in areas outside home.

<table>
<thead>
<tr>
<th>Type of Equipment</th>
<th>User’s Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>A급 기기 (업무용 방송통신기자재)</td>
<td>이 기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바랍니다. 가정외의 지역에서 사용하는 것을 목적으로 합니다.</td>
</tr>
<tr>
<td>Class A Equipment (Industrial Broadcasting &amp; Communication Equipment)</td>
<td>This equipment is <em>Industrial (Class A) electromagnetic wave suitability equipment</em> and seller or user should take notice of it, and this equipment is to be used in the places except for home.</td>
</tr>
</tbody>
</table>

**International**
This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for a Class A Digital device.

**Notice** — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

**Maintenance/User Serviceable Parts**
Routine maintenance to this openGear product is not required. This product contains no user serviceable parts. If the module does not appear to be working properly, please contact Technical Support using the numbers listed under the “Contact Us” section of this manual. All openGear products are covered by a generous 5-year warranty.
and will be repaired without charge for materials or labor within this period. See the “Warranty and Repair Policy” section in this manual for details.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment. To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You can also contact Ross Video for more information on the environmental performances of our products.

Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
Contents

Introduction ..................................................................................................................11
  Related Publications ........................................................................................................11
  Documentation Conventions ...............................................................................................12
  Interface Elements ............................................................................................................12
  User Entered Text ...........................................................................................................12
  Referenced Guides ..........................................................................................................12
  Menu Sequences .............................................................................................................12
  Important Instructions ....................................................................................................12
  Contacting Technical Support .......................................................................................12

Before You Begin ..........................................................................................................13
  Features ..........................................................................................................................13
  What are Devices, Senders, Flow, and Streams? ...............................................................13
  Example of a Source and a Sender Device Work Flow .......................................................14
  Example of a Receiver and Destination Device Work Flow ................................................14
  System Overview Diagram ...............................................................................................15
  Video/IP Flow Diagram ..................................................................................................16
  Installation and Setup Overview ......................................................................................16

Hardware Overview ......................................................................................................17
  Overview ..........................................................................................................................17
  Main PCB Overview .........................................................................................................17
  RAPTOR-IPG Rear Module Overview ..............................................................................18

Physical Installation .......................................................................................................21
  Before You Begin .............................................................................................................21
  Static Discharge ................................................................................................................21
  Working with Fiber Optic Connectors ...............................................................................21
  Installing the RAPTOR-IPG into the openGear Frame .......................................................21
  Removing a Blank Plate from the openGear Rear Panel ....................................................21
  Installing the Rear Module into the openGear Frame .......................................................22
  Installing the RAPTOR-IPG Card into an openGear Frame ...............................................23

Cabling ..........................................................................................................................25
  Cabling the Ethernet Ports ................................................................................................25
  Before You Begin .............................................................................................................25
  Cabling the SFP Ports .......................................................................................................25
  Video Signal Cabling .......................................................................................................26
  SDI Inputs .........................................................................................................................26
  SDI Outputs .....................................................................................................................27

Getting Started ..............................................................................................................29
  Before You Begin .............................................................................................................29
  Configuration Overview .................................................................................................29
  Launching DashBoard .....................................................................................................29
  Configuring the Initial Network Settings .........................................................................29
  Using the Initial Setup Wizard ........................................................................................29
  Accessing the RAPTOR-IPG User Interfaces in DashBoard ..........................................31
## Contents

**Configuring the Ethernet Settings** ........................................... 33
  - Configuring the Internal Frame Ethernet Settings .................. 33
  - Configuring the SFP Ports .................................................. 34
  - Using a Multicast Whitelist .................................................. 34
  - Defining a Multicast Whitelist .............................................. 34

**Transport Protocol Setup** ....................................................... 37
  - Specifying the Sender Payload Type ..................................... 37
  - Registration and Discovery .................................................. 37
  - RAvenNA Support .............................................................. 38
  - RTSP Support .................................................................. 38
  - Ember+ Support ............................................................... 39
  - SAP Support .................................................................. 43
  - NMOS Support ................................................................ 43
  - Setting up Protection Switching .......................................... 44
  - Before You Begin .............................................................. 44
  - Enabling the Protection Switching Feature ......................... 44
  - Configuring the RAPTOR-IPG for Protection Switching ....... 44

**Configuring the Timing Settings** .............................................. 45
  - Specifying a Reference Format Rate .................................... 45
  - Configuring the PTP Settings ............................................. 45
  - Configuring the Video Delay and Audio Offset .................... 46
  - Setting the Audio Packet Time ......................................... 47

**Configuring the Receivers** ...................................................... 49
  - Configuring a Receiver ....................................................... 49
  - Using the Disconnect Button ............................................. 50
  - Assigning a Test Pattern to the SDI Output ......................... 50

**Configuring the Senders** ......................................................... 53
  - Configuring the Active Video Properties ......................... 53
  - Configuring the Active Audio Properties .......................... 54
  - Mapping the Audio Channels to a Sender Stream ............... 54

**Setting up the Network Streams** .............................................. 57
  - Overview ......................................................................... 57
  - Advertised Streams .......................................................... 57
  - Manually Assigning a Stream .......................................... 57
  - Adding a Network Stream ............................................... 57

**Operation** ............................................................................. 59
  - Connections Tab Overview .............................................. 59
  - Routing the Signals .......................................................... 59
  - Performing a Breakaway .................................................. 60

**Ultritouch-2 Support** ............................................................... 61
  - Connecting the openGear Frame and Ultritouch-2 ............. 61
  - Accessing the RAPTOR-IPG Interfaces ............................. 61

**Monitoring** ........................................................................... 63
  - Monitoring the Receiver Streams ....................................... 63
  - Notes on Monitoring the Receiver Streams ......................... 63
Introduction

This guide covers the installation, configuration, and use of the RAPTOR-IPG IP/SDI Media Processing Engine. The following chapters are included:

- "Introduction" summarizes the guide and provides important terms, and conventions.
- "Before You Begin" provides a brief product overview and installation requirements for the RAPTOR-IPG.
- "Hardware Overview" describes the RAPTOR-IPG hardware components including the supported rear modules.
- "Physical Installation" provides instructions for the basic physical installation of the RAPTOR-IPG card in an openGear frame.
- "Cabling" provides an overview of the connecting senders and receiver devices to the rear module of the RAPTOR-IPG card.
- "Getting Started" outlines how to display the RAPTOR-IPG interfaces in DashBoard, and how to re-name the card for easy identification.
- "Configuring the Ethernet Settings" provides instructions for configuring the RAPTOR-IPG network settings.
- "Transport Protocol Setup" provides information for setting up communications using third-party protocols.
- "Configuring the Timing Settings" provides instructions for configuring the card to use Precision Time Protocol, and specifying a reference source.
- "Configuring the Receivers" provides instructions for configuring a receiver channel for video streaming.
- "Configuring the Senders" provides instructions for configuring the ASI outputs, and the IP outputs.
- "Setting up the Network Streams" outlines how to define the network sources that the RAPTOR-IPG can access.
- "Operation" provides general information for operating the RAPTOR-IPG.
- "Ultritouch-2 Support" provides information for using an Ultritouch-2 panel to operate and monitor the RAPTOR-IPG.
- "Monitoring" describes the stream monitoring features and how to upgrade the card software in the DashBoard interfaces.
- "Upgrading the Software" outlines how to upgrade the RAPTOR-IPG the options available in DashBoard.
- "DashBoard Interface Overview" summarizes the functions, menus, and parameters of the RAPTOR-IPG tabs, menus, and parameters in DashBoard.
- "Technical Specifications" provides the specifications for the RAPTOR-IPG.
- "Service Information" provides information on the warranty and repair policy for your RAPTOR-IPG.
- "Software Licenses" provides third-party software license information for your RAPTOR-IPG.
- "Glossary" provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your RAPTOR-IPG:

- *DashBoard User Manual*, Ross Part Number: 8351DR-004
- *MFC-OG3-N and MFC-8322-S User Manual*, Ross Part Number: 8322DR-004
Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the **Edit** dialog, click **Insert Above**.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the **Language** box, enter **English**.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the *DashBoard User Manual*.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a step reads “**File > Save As**,” you would select the **File** menu and then select **Save As**.

Important Instructions

Star icons are used to identify important instructions or features. For example:

★ Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your card.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support**: (+1) 613-652-4886
- **After Hours Emergency**: (+1) 613-349-0006
- **E-mail**: techsupport@rossvideo.com
- **Website**: http://www.rossvideo.com
Before You Begin

This chapter provides an overview of the RAPTOR-IPG and possible work flow examples.

Features

Some features of the RAPTOR-IPG include:

• IP packet transport to SDI video, and embedded audio
• Supports the following encapsulation modes:
  › SMPTE ST 2110-10
  › SMPTE ST 2110-20
  › SMPTE ST 2110-30
  › SMPTE ST 2110-50
• Two 10GbE interfaces support up to 6 Tx + 6 Rx video and 6 Tx + 6 Rx streams of audio
• Glitch-less PTP Grandmaster switchover
• Provides protection switching per SMPTE ST 2022-7
• SMPTE ST 2059 PTP slave support
• RAVENNA Session announcement, discovery, and registration
• NMOS IS-04 and IS-05 discovery, registration, and connection control
• Ember+ (BESS 1.1) connection control
• Full DashBoard control
• Support for Ultritouch-2 operation
• Supported by the OGX-FR series frames

What are Devices, Senders, Flow, and Streams?

Before proceeding, you may wish to review the following terms:

Device

A physical, virtual, or software application that may include multiple sources, destinations, senders, or receivers.

Essence

A single elementary logical media signal. For example, a video essence is one video channel. An audio essence is a single audio (mono) channel.

Flow

The continuous raw media content. It can contain more than one essence (e.g. an audio flow can contain multiple channels, and an SDI flow may contain audio and video essences).

A flow is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is one type of stream which can carry the flow.

Flows cannot generally be passed around natively, and need to be encapsulated in a stream. Flows from the same source are considered “editorially equivalent”, but may be encoded differently. For example, a video source may be encoded as 4:2:2 YPrPb uncompressed, 4:4:4 RGB uncompressed, and h.265 encoded. Each of these would be a separate flow from a common source.

Receiver

An element within a device which that receives exactly one stream, which contains one flow from a network.
Sender
An element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream
One flow, encapsulated within a transport protocol. Examples include SMPTE ST 2110-20 Video, or SMPTE ST 2110-30 Audio (AES67).

Example of a Source and a Sender Device Work Flow

Figure 2.1 provides a general example of device, sender, flow, and stream where the Device is a dual-source video server producing multiple flows from the source labeled Channel 1 including a full-resolution 4:2:2 flow, and an h.264 low-resolution proxy flow. The full-resolution flow then feeds two senders.

*y* RAPTOR-IPG currently supports 1:1 mapping between source, flow, and sender for each of its SDI IN ports.

Example of a Receiver and Destination Device Work Flow

Figure 2.2 provides a generalized example of Device, Stream, Receiver, Flow, and Destination objects. In this example the destination object is a Multiviewer device with three PiPs (Picture-in-Picture) as destinations.
System Overview Diagram

In the context of the RAPTOR-IPG, Studio Video Over IP (SVIP) can be summarized in Figure 2.3 where:

1. a **Source** feeds an SDI signal into an SDI IN BNC on one RAPTOR-IPG
2. an essence signal is packed into a **Stream** by the **Sender** onto the network
3. the **Stream** is re-assembled by the **Receiver** of the second RAPTOR-IPG
4. a **Destination** feeds the signal from the SDI OUT BNC on the second RAPTOR-IPG

![Figure 2.3 System Overview Diagram](image-url)
Video/IP Flow Diagram

Installation and Setup Overview

The generalized work flow of installing and configuring your RAPTOR-IPG is:

1. Download and install the latest version of the DashBoard client software.
2. Contact your IT department for the required IP addresses for your RAPTOR-IPG.
3. Physically install and cable the RAPTOR-IPG.
4. Use DashBoard to access the RAPTOR-IPG.
5. Use the Initial Setup Wizard to configure the basic settings for your module.
7. Make your connections.
Hardware Overview

This chapter presents information on the RAPTOR-IPG card-edge controls and features.

Overview

Up to five RAPTOR-IPG modules may be installed into an openGear or an OGX-FR series frame.

Each RAPTOR-IPG consists of:

- a main PCB
- an audio daughter card
- a rear module

The RAPTOR-IPG assembly requires four slots in the openGear frame.

Main PCB Overview

The main PCB is a typical openGear card. An ejector on one end secures the module to the slot inside the openGear frame and the other end inserts into a connector on the back of the rear module.

Reset Button

Pressing this button resets the microprocessor and re-initializes the card. This is a hard reset of the card. This action should only be performed when advised by Ross Video Technical Support.
Micro SD Card

The main PCB also includes a Micro SD card. This SD card is located on the back face of the main PCB and above the ejector. (Figure 3.3)

![Figure 3.3  RAPTOR-IPG — Micro SD Card Location]

Ensure the SD card is properly seated in its slot on the PCB before installing the RAPTOR-IPG in the openGear frame.

Card-edge LEDs

When the card is powered and operational:

- LED DS1 is lit red
- LEDs DS22 and DS23 are lit green.

Any other LED pattern could indicate a problem and Tech Support should be consulted.

RAPTOR-IPG Rear Module Overview

This section provides an overview of the connections and cabling designations for each rear module the RAPTOR-IPG supports.

Notice — Installing the RAPTOR-IPG in a frame other than the openGear could damage the card, the rear module, or both.

For More Information on...

- connecting specific signals to your rear module, refer to the chapter “Cabling” on page 25.

The RAPTOR-IPG requires the 8322AR-319A rear module. The following connections are available:

- 2 SFP+ for 10GbE network interface
- 6 HD-BNC inputs (3G SDI)
- 6 HD-BNC outputs (3G SDI)

Refer to Figure 3.4 for the implemented cabling designations.
Figure 3.4 RAPTOR-IPG — Implemented Connections
Physical Installation

If you have questions pertaining to the installation of RAPTOR-IPG, contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

For More Information on...

• the technical specifications for the RAPTOR-IPG, refer to the chapter “Technical Specifications” on page 97.

Before You Begin

These installation guidelines assume the following:

• Ensure the openGear frame is properly installed. Refer to the frame’s User Guide for details.
• A valid IPV4 address is available for the RAPTOR-IPG.
• A PTP Grandmaster is configured and available for communicating with the RAPTOR-IPG.
• A network switch is configured in Boundary Clock mode and available for communicating with the RAPTOR-IPG.

Static Discharge

Throughout this chapter, please heed the following cautionary note:

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit boards and related equipment.

Working with Fiber Optic Connectors

Keep the following in mind when working with fiber optic connectors:

• Every time you are required to insert a connector into a device or mating sleeve, you must clean the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility practices of cleaning fiber optic connectors.
• Connectors must always be inserted into a device or have a dust cap on.
• A poor optical connection is often similar to a poor electrical connection. Try removing the connector, cleaning, and re-inserting the connector. A bad connection can result in experiencing signal instability, high loss, or a noisy signal.

Installing the RAPTOR-IPG into the openGear Frame

Installing an RAPTOR-IPG card into the openGear frame requires you to remove the blank plates in the designated frame slots, install the required rear module into the frame rear panel, and then install the RAPTOR-IPG assembly into the required frame slots.

Removing a Blank Plate from the openGear Rear Panel

When a frame slot is not populated with an openGear card, a blank plate must be installed to ensure proper frame cooling and ventilation. Each rear module occupies four slots in the frame, but accommodates one card.

★ Each rear module requires you to remove two Blank Plates (covering four slots) in the openGear frame.
To remove a blank plate from the openGear frame

1. Locate the slots in the openGear frame you wish to install the RAPTOR-IPG into. It is recommended to use the following slot combinations:
   - Slots 1, 2, 3, 4
   - Slots 5, 6, 7, 8
   - Slots 9, 10, 11, 12
   - Slots 13, 14, 15, 16
   - Slots 17, 18, 19, 20

2. Use a Phillips #1 screwdriver to unfasten each blank plate from the openGear backplane.

3. Remove each blank plate from the chassis and set aside.

Installing the Rear Module into the openGear Frame

The rear module requires four slots in the openGear frame. You must affix the rear module to the frame backplane using the two retaining screws located at the top of the rear module.

![Figure 4.1 Rear Module Backplane — Adjusting the O-rings](image)

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit boards and related equipment.

To install a rear module into the openGear frame

1. For each retaining screw on the rear module, push the o-ring to the end of the screw on the last couple of threads (but not off the screw). This will help to align the rear module to the frame backplane in step 3.

2. Seat the bottom of the rear module in the seating slots at the base of the openGear frame’s backplane.

3. Align the top holes of the rear module with the holes on the top-edge of the frame backplane.

4. Using a Phillips screwdriver and the provided screws, fasten the rear module to the backplane.

★ Do not fully tighten the screws until after the RAPTOR-IPG card is installed and alignment with the rear module is verified.
Installing the RAPTOR-IPG Card into an openGear Frame

The slot the RAPTOR-IPG installs into depends on the slot combination you installed the rear module in. This allows adequate spacing to avoid damaging the card, the cards installed in the neighboring slots, or both. Refer to Table 4.1 for valid slot combinations.

<table>
<thead>
<tr>
<th>Rear Module is Installed in</th>
<th>Card Installs into Slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slots 1, 2, 3, 4</td>
<td>2</td>
</tr>
<tr>
<td>Slots 5, 6, 7, 8</td>
<td>6</td>
</tr>
<tr>
<td>Slots 9, 10, 11, 12</td>
<td>10</td>
</tr>
<tr>
<td>Slots 13, 14, 15, 16</td>
<td>14</td>
</tr>
<tr>
<td>Slots 17, 18, 19, 20</td>
<td>18</td>
</tr>
</tbody>
</table>

To install the RAPTOR-IPG into the openGear frame

1. Locate the slot the RAPTOR-IPG card will slide into.
2. Verify that the RAPTOR-IPG card aligns with the rear module.
3. Hold the card by the edges and carefully align the card edges with the slot rails in the frame.
4. Fully insert the card into the frame until the card is properly seated in the rear module.
5. Secure the rear module to the backplane using a Phillips screwdriver and the two retaining screws.

* Do not over tighten the retaining screws.
Cabling

If you have questions pertaining to the installation of RAPTOR-IPG, contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

For More Information on...
- the technical specifications for the RAPTOR-IPG, refer to the chapter “Technical Specifications” on page 97.
- the cabling designations, refer to the chapter “Cabling Guide” on page 87.

Cabling the Ethernet Ports

The RAPTOR-IPG is connected to your network via the openGear frame so that it can interface with the devices and the computer running the DashBoard client software. After the RAPTOR-IPG is installed in the frame, DashBoard is used to configure the network settings for the RAPTOR-IPG.

★ If difficulties or problems are experienced when connecting the RAPTOR-IPG to a network hub, contact your network administrator.

This section presents a general overview of the Ethernet connection process. The exact steps for connecting your RAPTOR-IPG to your facility via an Ethernet network depend on the network requirements of your facility. You must provide an Ethernet connection to the openGear frame as outlined in the user guide that accompanied your frame. The Ethernet connection on the frame is used for communications, and software upgrades using DashBoard.

For More Information on...
- cabling the Ethernet port on the openGear frame, refer to the frame’s User Guide.

Before You Begin

Keep the following in mind before connecting the Ethernet ports on the rear module to your network:
- Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

Cabling the SFP Ports

⚠️ **Caution** — *Never attempt to look down the barrel of a connected fiber or device transmitting an optical signal. The transmitted light is not in the visible spectrum and may cause permanent eye damage. Turn off all laser sources before disconnecting devices.*

The primary function of SFP modules is to provide up to two additional Ethernet ports for the RAPTOR-IPG. Each SFP provides a 10GbE network interface and can be configured to send and receive network streams in DashBoard. The SFP designations are the same regardless of the rear module used.

★ Contact Ross Technical Support for a list of supported SFP modules.

⚠️ **Caution** — *Every time you are required to insert a connector into a device or mating sleeve, you must clean the connector. All exposed surfaces of the ceramic ferrule must be clean. Follow your facility practices of cleaning fiber optic connectors. Connectors must always be inserted into a device or have a dust cap on.*
To connect an SFP port to a network port

1. Remove the dust caps from each of the SFP port connectors on the rear module.
   - Refer to Figure 5.1 for connector location.
   - Refer to the “Important Laser Safety Measures and Notices” document that accompanied your card for safety information when handling fiber optic components.

2. Ensure that the exposed surface of the ceramic ferrule of each connector is clean. Refer to the section “Working with Fiber Optic Connectors” on page 21 for cleaning tips.

3. Cable your rear module as required. (Figure 5.1)

Video Signal Cabling

Each rear module provides connections for up to six SDI inputs and six SDI outputs.

SDI Inputs

Connect your input video signals to the six SDI IN HD-BNCs on the rear module as required. Refer to Figure 5.2.
SDI Outputs

Connect your destination devices to the six SDI OUT HD-BNCs on the rear module. Refer to Figure 5.3.

![Figure 5.3 Rear Module Cabling — SDI Outputs](image-url)
Getting Started

This chapter provides instructions for launching DashBoard, assigning an initial IP address to the RAPTOR-IPG, and accessing the tabs and menus in DashBoard.

Before You Begin

Ensure that:

- A valid IPv4 address is available for the RAPTOR-IPG.
- A PTP Grandmaster is configured and accessible for the RAPTOR-IPG.
- A network switch is configured in Boundary Clock mode and available for communicating with the RAPTOR-IPG.

Ensure that your facility IT Department provided the required network settings to be assigned to the RAPTOR-IPG and each SFP port you plan to enable.

- An MFC-OG3-N or an MFC-8322-N Network Controller Card installed in your openGear frame.
- The openGear frame that houses the RAPTOR-IPG displays in the Basic Tree View of DashBoard.
- The RAPTOR-IPG displays as a sub-node in the openGear frame tree.

Configuration Overview

The generalized work flow of configuring your RAPTOR-IPG is summarized in Figure 6.1.

Launch DashBoard

DashBoard must be run on a computer that is connected to the same network as the RAPTOR-IPG.

For More Information on...

- downloading and installing the DashBoard client software, refer to the DashBoard User Manual.
- the RAPTOR-IPG interfaces in DashBoard, refer to the chapter “DashBoard Interface Overview” on page 69.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.0 or higher.
2. Launch DashBoard by double-clicking its icon on your computer desktop.

Configuring the Initial Network Settings

Once the RAPTOR-IPG is physically installed and cabled to your facility network, you will need to assign it an initial static IP Address in order to display the card menus, options, and status fields in DashBoard. Establishing an initial IP Address enables DashBoard to communicate with the RAPTOR-IPG and update the Basic Tree View with the RAPTOR-IPG sub-nodes.
To assign the initial network settings for the RAPTOR-IPG

1. Launch Dashboard.
2. Expand the openGear frame node to display a list of sub-nodes.
   • Each sub-node represents a card installed in that frame.
3. Double-click the RAPTOR-IPG node under the frame node.
   The Network interface displays in Dashboard.
   
4. Use the Mode menu to select Static.
5. Use the Static IP Address field to assign a unique IP Address to the RAPTOR-IPG card.
6. Use the Subnet Mask field to assign the subnet mask for the card.
7. Use the Gateway field to specify the gateway for communications outside of the local area network (LAN) the card will use.
8. Click Apply.
9. To apply the new network settings, click Reboot. This button is located at the bottom of the Network interface.
   The card is temporarily taken off-line during the reboot.
10. Verify the new network settings:
    a. Expand the openGear frame node to display a list of sub-nodes.
    b. Expand the RAPTOR-IPG node.
    c. Double-click the RAPTOR-IPG sub-node in the Tree View.
    d. Select the Advanced tab in the right pane of the Dashboard window.
    e. Select the Ethernet I/O tab.
Using the Initial Setup Wizard

Double-click the **RAPTOR-IPG** sub-node in the Tree View of DashBoard and select the **Initial Setup** tab.

![Example of the Initial Setup Tab](image)

Use the **Initial Setup Wizard** to configure the following settings:

- Re-name the RAPTOR-IPG in DashBoard
- IP Address for the CONTROL port
- IP Address for each SFP port
- System Frame Rate
- PTP Timing System
- Audio Packet Time
- Audio Channel Count mode
- Sender Sources

These steps are further described in the proceeding chapters.

**Accessing the RAPTOR-IPG User Interfaces in DashBoard**

The user interfaces are accessed by double-clicking the RAPTOR-IPG node in the DashBoard Tree View. This procedure assumes that you have launched DashBoard on your computer and a valid IP Address assigned to the RAPTOR-IPG.

如果您无法访问用户界面，请参阅第29页的“**Configuring the Initial Network Settings**”部分。

**To access the RAPTOR-IPG user interfaces in DashBoard**

1. In the Basic Tree View of DashBoard, locate the openGear frame the RAPTOR-IPG is installed in.
2. Expand the openGear frame node to display a list of sub-nodes.
3. Expand the RAPTOR-IPG node.
4. Double-click the **RAPTOR-IPG** sub-node to display the RAPTOR-IPG interface in the right pane of the DashBoard window.
The DashBoard window is organized into a series of tabs with the Welcome tab automatically selected.

5. Select a tab to display its options in the right-side of the DashBoard window.
   In the example below, the user selected Advanced.
Configuring the Ethernet Settings

The RAPTOR-IPG provides up to two SFP ports that can be populated with Ethernet connectors. The openGear frame also provides Ethernet connections via the ports on its rear panel, and the Network Controller Card installed in the frame. This chapter outlines how to configure each of these ports.

* If difficulties or problems are experienced when assigning IP addresses, contact your network administrator.

Configuring the Internal Frame Ethernet Settings

You can specify the network settings that will be used when the RAPTOR-IPG utilizes the GigE network switch available on the Network Controller Card installed in the same openGear frame.

The port on the Network Controller Card enables RAPTOR-IPG to communicate with DashBoard and with other cards in the same openGear frame.

* Ross Video recommends using a static IP Address.

To specify the network settings for the RAPTOR-IPG to use via the Network Controller Card

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.

* If the RAPTOR-IPG does not display a sub-node, refer to the section “Configuring the Initial Network Settings” on page 29.

2. Double-click the RAPTOR-IPG sub-node.

3. Select Advanced > Ethernet I/O.

4. Locate the openGear Chassis RJ-45 column of the tab.

5. If you are manually configuring the Ethernet settings for the RAPTOR-IPG:
   a. Use the Mode menu to select Static.
   b. Use the Static IP Address field to specify the new static IP Address for the RAPTOR-IPG. This is the address the card will use within the openGear frame.
   c. Use the Subnet field to specify the subnet mask for your network.
   d. Use the Gateway field to specify the gateway for communication outside of the local area network (LAN).

6. If you want the network settings to be automatically obtained, select DHCP from the Mode menu.
7. Click Apply to save the new settings.
8. Reboot the RAPTOR-IPG as follows:
   a. Click Reboot. This button is located on the bottom of the Ethernet I/O tab.
   b. Monitor the reboot progress.

Configuring the SFP Ports

By assigning an IP Address to each SFP port, you are able to uniquely identify it on the network and control it via the DashBoard interface. Each SFP port on the rear module can be configured for media traffic for the RAPTOR-IPG.

This section outlines how to configure the network settings for the SFP ports on the rear module.

For More Information on...

• the SFP designations on the rear module, refer to the section “RAPTOR-IPG Rear Module Overview” on page 18.

To update the network settings for an RAPTOR-IPG SFP port

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the RAPTOR-IPG sub-node.
3. Select Advanced > Ethernet I/O.
4. Locate the options for the SFP you wish to configure.
5. If you are manually configuring the Ethernet settings:
   a. Use the Mode menu to select Static.
   b. Use the Static IP Address field to specify the new static IP Address for the RAPTOR-IPG. This is the IP Address that is used to control and communicate with the specific SFP port.
   c. Use the Subnet field to specify the subnet mask for the SFP port.
6. If you want the network settings for the SFP port to be automatically obtained, select DHCP from the Mode menu.
7. Click Apply to save the new settings.
8. Repeat this procedure for the second SFP port you wish to configure.
9. Reboot the RAPTOR-IPG as follows:
   a. Click Reboot. This button is located on the bottom of the Ethernet I/O tab.
   b. Monitor the reboot progress.

Using a Multicast Whitelist

Through DashBoard, the RAPTOR-IPG senders can be configured with any destination multicast IP address in the range of 225.x.x.x to 239.x.x.x. Receivers on the RAPTOR-IPG can also be configured to connect to a network stream with any multicast destination IP address in the same range. If you require exceptions to this default configuration, you can create a programmable whitelist of up to eight entries that specify the exceptions.

Defining a Multicast Whitelist

You can create a programmable whitelist of up to eight entries with three read-only entries and five user configurable entries. Each whitelist entry includes: a 32bit IP address, a 32bit IP address mask, and 1bit entry enable. Defining a whitelist entry is done via DashBoard using the options in the Advanced > Ethernet I/O tab.
The addresses 225.1.1.1, 239.255.255.255, and 239.255.255.253 are automatically added to the whitelist as the three read-only entries.

**To define a multicast whitelist**

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the RAPTOR-IPG sub-node.
3. Select Advanced > Ethernet I/O.
4. Locate the Special Multicast Addresses area on the tab.
5. Click Configure.

The Multicast Whitelist dialog opens.

6. Use the first row of editable IP Address and Mask fields to define the first network stream exception.
7. Click Add to create the entry in the list.
8. Click Enable for the new entry.
9. Repeat steps 6 to 8 for the remaining rows to define additional streams you wish to exclude.
10. To close the dialog, click in the top right corner of the dialog.
Transport Protocol Setup

This chapter provides information on the distribution methods the RAPTOR-IPG supports.

Specifying the Sender Payload Type

You can specify the methodology the RAPTOR-IPG will use for encapsulating the data to send to the downstream equipment in your system.

★ Changes to the RAPTOR-IPG code settings requires a reboot of the card to commit the changes.

To specify the sender payload type for the RAPTOR-IPG

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the RAPTOR-IPG sub-node.

4. Use the SMPTE ST 2110-20 Sender Payload Type field to specify the 7bit numeric value that identifies the SMPTE 2110-20 RTP payload format the RAPTOR-IPG supports. The default is 98.
5. Use the SMPTE ST 2110-30 Sender Payload Type field to specify the 7bit numeric value that identifies the SMPTE 2110-30 RTP payload format the RAPTOR-IPG supports. The default is 97.
6. Click Apply to save the new settings.
7. Reboot the RAPTOR-IPG as follows:
   a. Click Reboot. This button is located on the bottom of the Device Setup tab.
   b. Monitor the reboot progress.

Registration and Discovery

The RAPTOR-IPG supports media distribution based on RAVENNA, RTSP, NMOS, and Ember+. This section outlines how to configure the RAPTOR-IPG for each protocol.
RAVENNA Support

This section outlines how to configure the RAPTOR-IPG for the open standard for real-time media over IP (AES67).

**To configure the RAPTOR-IPG as a RAVENNA device**

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the **RAPTOR-IPG** sub-node.
3. Select **Advanced > Discovery**.
4. Locate the **RAVENNA** area in the tab.
5. To re-name the card, perform one of the following:
   - Use the **Board Name** menu to specify a unique identifier for the card in the RAVENNA network; or
   - Click **Use System Device Name**.
6. Use the **Interface** menu to specify what port on the rear module the RAPTOR-IPG will use for RAVENNA communications.
7. Use the **Port** menu to specify the port assigned to the RAPTOR-IPG within the RAVENNA network.
8. Click **Apply** to save the new settings.
9. Reboot the RAPTOR-IPG as follows:
   a. Click **Reboot**. This button is located on the bottom of the **Discovery** tab.
   b. Monitor the reboot progress.

RTSP Support

This section outlines the required settings when establishing communications between RAPTOR-IPG and an external device via the Real Time Streaming Protocol (RTSP).

**To configure the RAPTOR-IPG as an RTSP device**

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the **RAPTOR-IPG** sub-node.
3. Select **Advanced > Discovery**.
4. Locate the **RTSP** area in the tab.
5. Use the **Interface** menu to specify what physical port the RAPTOR-IPG uses for RTSP communications.
6. Use the **Port** field to specify the TCP port the protocol uses to send and receive messages.
7. Click **Apply** to save the new settings.
8. Click **Reboot** to apply the new settings. This button is located at the bottom of the interface.
   
   The RAPTOR-IPG is temporarily taken off-line during the reboot.
9. Monitor the reboot progress.

**Ember+ Support**

⭐ RAPTOR-IPG implements BESS v1.1 for Ember+ support to communicate with third-party controllers.

Keep the following in mind when setting up an Ember+ connection with RAPTOR-IPG:

- Ensure that all network streams have a consistent audio channel count.
- Audio shuffling is not supported in Ember+ setups.
- RAPTOR-IPG supports one-to-many connections (where one source can be routed to multiple targets).
- The video and audio offsets set in DashBoard are automatically applied for Ember+ connections. Refer to the section “**Configuring the Video Delay and Audio Offset**” on page 46 for details on setting these offsets.

**Video Signal Mapping for Ember+**

Each Group in the Ember+ tree represents a different physical SDI interface on RAPTOR-IPG (Group 1 represents SDI 1, Group 2 represents SDI 2, etc.) The video SDI signal in the network stream is mapped to Video 1 in the Ember+ client.

**Audio Channel Mapping for Ember+**

There are 16 audio channels per SDI signal (and therefore 16 channels per group since each group represents an SDI signal). Channels in the network stream are mapped to the corresponding audio channels in the Ember+ client in a 1-to-1 mapping.

In each channel count mode, the Sender configuration must first be created in DashBoard to show up in the Ember+ tree. If a Sender is not set up through DashBoard for one of these sets of channels, then the Audio sub-groups will not contain an SDP file. If a Sender is created without following the channel mapping configuration above, the Ember+ tree contents will not be correct.

**16-channel Audio Count Mode**

In 16-channel count mode, there is only one Audio sub-group (Audio 1) per Group. Each SDI/Group has 16 channels, so all channels are represented as a single sub-group of that SDI signal. *(Figure 8.1)*

![Figure 8.1 Ember+ Tree Example — Channel Count Mode Set to 16](image)
In Figure 8.1, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channels 1 to 16 of SDI 1; Receivers > Group 2 > Audio 1 represents the receiver that maps to audio channels of SDI 2. When connecting a 16-channel network stream to one of these targets, the 16 channels from the network stream will be mapped to the corresponding audio channels in a 1-to-1 mapping.

In Figure 8.1, the Transmitters > Group 1 > Audio 1 represents the sender that maps to audio channels 1 to 16 of SDI 1. The Transmitters > Group 1 > Video 1 group represents the video of the SDI signal.

8-channel Count Mode

If the channel count mode is set to 8, each SDI/Group includes 2 audio sub-groups (Audio 1-8 and Audio 9-16 respectively). The Video 1 sub-group represents the video of the SDI signal. (Figure 8.2)

In Figure 8.2, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channels 1 to 8 for SDI 1; Receivers > Group 1 > Audio 2 represents the receiver that maps to audio channels 9 to 16 for SDI 1. When connecting an 8-channel network stream to one of these targets, the 8 channels from the network stream will be mapped to the corresponding audio channels in a 1-to-1 mapping.

In Figure 8.2, the Transmitters > Group 1 > Audio 1 represents the sender that maps to audio channels 1 to 8 for SDI 1; Audio 2 maps to the sender that maps to audio channels 9 to 16 for SDI 1; etc.

4-channel Count Mode

If the channel count mode is set to 4, each SDI/Group includes 4 audio sub-groups (Audio 1-4, Audio 5-8, Audio 9-12, and Audio 13-16 respectively). The Video 1 sub-group represents the video of the SDI signal. (Figure 8.3)
In Figure 8.3, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channels 1 to 4 for SDI 1; Receivers > Group 1 > Audio 2 represents the receiver that maps to audio channels 5 to 8 for SDI 1, etc. When connecting a 4-channel network stream to one of these targets, the 4 channels from the network stream will be mapped to the corresponding audio channels in a 1-to-1 mapping.

In Figure 8.3, the Transmitters > Group 1 > Audio 1 represents the sender that maps to audio channels 1 to 4 for SDI 1; Audio 2 maps to the sender that maps to audio channels 5 to 8 for SDI 1; etc.

2-channel Count Mode

If channel count mode is set to 2, there are 8 audio sub-groups with 2 channels each per SDI/Group. The Video 1 sub-group represents the video of the SDI signal. (Figure 8.4)

In Figure 8.4, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channels 1 and 2; Receivers > Group 1 > Audio 2 represents the receiver that maps to audio channels 3 and 4; etc. When connecting a
2-channel network stream to one of these targets, the 2 channels from the network stream will be mapped to the corresponding audio channels in a 1-to-1 mapping.

In Figure 8.4, the Transmitters > Group 1 > Audio 1 represents the sender that maps to audio channels 1 and 2; Audio 2 maps to the sender that maps to audio channels 3 and 4; etc.

1-channel Count Mode

If channel count mode is set to 1, there are 16 audio sub-groups (Audio 1-16) with 1 channel each. The Video 1 sub-group represents the video of the SDI signal (Figure 8.5).

![Figure 8.5 Ember+ Tree Example — Channel Count Mode Set to 1](image)

In Figure 8.5, the Receivers > Group 1 > Audio 1 represents the receiver that maps to audio channel 1 of SDI 1; Receivers > Group 1 > Audio 2 represents the receiver that maps to audio channel 2 of SDI 2; etc. The Video 1 group represents the video of the SDI signal.

In Figure 8.5, the Transmitters > Group 1 > Audio 1 represents the sender that maps to channel 1 of SDI 1; Audio 2 maps to the sender that maps to audio channel 2 of SDI 2; etc. The Video 1 group represents the video of the SDI signal.

Establishing a Connection

★ Before proceeding, ensure that SDP patching is enabled with the Ember+ client to establish audio receivers on the RAPTOR-IPG.

To establish a connection between the Ember+ client and the RAPTOR-IPG

1. Add the RAPTOR-IPG in the Ember+ client interface using the IP Address assigned to the RAPTOR-IPG.
2. In Dashboard:
   a. Navigate to RAPTOR-IPG Advanced > Discovery tab.
   b. Locate the Ember+ area in the tab.
   c. Set the Port field to the same value as assigned in the Ember+ client interface. The default value for the Port field is 9095.
3. In the Ember+ client, set the TCP port to the same value you specified in step c for the RAPTOR-IPG.

Specifying the Audio Channel Count Mode on the RAPTOR-IPG

By default, the Channel Count mode is set to 8 but this value can be edited in Dashboard.
To set the Audio Channel Count mode on the RAPTOR-IPG

1. In DashBoard, navigate to the Advanced > Device Setup tab.
2. Use the Audio Channel Count Mode menu to specify the number of channels in each group.
3. Click Apply.

Configuring the RAPTOR-IPG for Ember+

For most setups, you will only need to create the Senders in DashBoard for the RAPTOR-IPG. Refer to the section “Mapping the Audio Channels to a Sender Stream” on page 54 for details.

For other setup types, you will need to configure the Senders, and then use the Ember+ controller interface (e.g. Lawo VSM) to map the sources to the targets. Refer to the documentation that came with your controller for details.

SAP Support

This section outlines how to enable the RAPTOR-IPG to use the Session Announcement Protocol (SAP) when broadcasting multicast session information.

To configure the RAPTOR-IPG to use SAP for multicast broadcasting

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the RAPTOR-IPG sub-node.
3. Select Advanced > Discovery.
4. Locate the SAP area in the tab.
5. Select the Enable box.
6. Click Apply to save the new settings.
7. Click Reboot to apply the new settings. This button is located at the bottom of the interface.
   The RAPTOR-IPG is temporarily taken off-line during the reboot.
8. Monitor the reboot progress.

NMOS Support

This section outlines the required settings on the RAPTOR-IPG to establish communications via the Network Media Open Specifications (NMOS).

To configure the RAPTOR-IPG as an NMOS device

1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the RAPTOR-IPG sub-node.
3. Select the Advanced > Discovery.
4. Locate the NMOS area in the tab.
5. To re-name the card, perform one of the following:
   • Use the Board Name and/or Node Name menus to specify a unique identifier for the RAPTOR-IPG in the NMOS network; or
   • Click Use System Device Name.
6. Use the Interface menu to specify what port on the RAPTOR-IPG rear module uses for NMOS communications.
7. Select the Enable box.
8. Click Apply to save the new settings.
9. Reboot the RAPTOR-IPG as follows:
   a. Click Reboot. This button is located on the bottom of the Discovery tab.
   b. Monitor the reboot progress.

Setting up Protection Switching

The RAPTOR-IPG enables a user to protect their streams to ensure mission critical operation. Using SMPTE ST 2022-7 they can run the same video and audio over two separate, redundant networks in case an error occurs with any hardware.

* This section is only applicable if your system requires protection switching.

Before You Begin

Ensure that:
- your source is capable of sending SMPTE ST 2022-7 streams
- the RAPTOR-IPG is set up within a protection switching network

Enabling the Protection Switching Feature

By default, the SMPTE ST 2022-7 Protection Switching feature is enable. Once enabled, the Receivers, and Network Streams tabs update to include options for configuring the Protection Switching streams.

* This feature is reset when the Load Factory Defaults button is selected.

To enable the Protection Switching feature
1. In the Tree View of DashBoard, expand the RAPTOR-IPG node.
2. Double-click the RAPTOR-IPG sub-node.
4. Locate the Transport Options area of the Device Setup tab.
5. Select the SMPTE ST 2022-7/Seamless Protection Switching box.
6. Click OK in the prompt confirming that all sessions will be removed.
7. Click Apply.
8. Click Reboot to apply the new settings. This button is located at the bottom of the interface.
   - The RAPTOR-IPG is temporarily taken off-line during the reboot.
9. Monitor the reboot progress.

Configuring the RAPTOR-IPG for Protection Switching

You will need to assign a unique IP address to each video stream (e.g. primary 239.1.1.1, secondary IP 239.1.1.2).

* Each stream should be assigned a unique IP address.

To configure the RAPTOR-IPG for protection switching
1. Configure the primary and secondary Receiver streams as outlined in “Configuring a Receiver” on page 49.
   - The UDP value can be the same or different for the primary and secondary streams.
2. Configure the primary and secondary Network streams. Refer to “Adding a Network Stream” on page 57.
3. Click Reboot. This button is located on the bottom of the interface.
4. Monitor the reboot progress.
Configuring the Timing Settings

The RAPTOR-IPG supports the Precision Time Protocol (PTP) as defined in the IEEE 1588-2008 standard and the SMPTE ST 2059 specification.

Specifying a Reference Format Rate

RAPTOR-IPG requires a PTP master on the media network to drive its timing. By default, the RAPTOR-IPG is configured to run as a PTP slave. If there is no lock to PTP, the RAPTOR-IPG will not receive IP streams.

★ You can also change these settings via the Advanced > Device Setup tab.

To specify a frame rate for the RAPTOR-IPG video signals

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Select the Initial Setup tab.
3. Use the System Frame Rate menu to specify a video frame rate that is compatible with the SDI signals that the RAPTOR-IPG will output.
4. Click Apply.
5. Click Reboot to apply the new setting.
★ The System Frame Rate setting will not be applied until the PTP is locked.

Configuring the PTP Settings

From the Timing tab in DashBoard, you can synchronize the card to real-time clocks of other devices in the same network.

★ There are several criteria that PTP clocks compare to determine who will be master and who will be slave (called the Best Master Clock Algorithm, or BMCA), and they are evaluated in order: Priority1, clock class, accuracy, scaled log variance, Priority2, clock ID (similar to the MAC address). Practically, Priority1 is the only setting configured on all clocks to control the outcome of the Grandmaster election. If Priority1s are equal, the next criterion is evaluated (clock class) and the criteria are evaluated in succession until a Grandmaster is determined.

To update the PTP settings for the RAPTOR-IPG

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Select the Initial Setup tab.
★ You can also change these settings via the Advanced > Device Setup tab.
3. Select the Slave Only box to define the RAPTOR-IPG as only a slave and never a Boundary Clock or Grandmaster device.
4. Use the Domain field to specify the sub-domain the PTP clock is assigned to.
★ There can be multiple PTP domains operating concurrently within a network. The domain is a field in all PTP message headers. Messaging between entities are segregated by domain (e.g. The card is an endpoint configured for domain 128 and ignores messages from a neighboring clock configured for domain 127).
5. If you did not select the Slave Only box and the card matches the primary Grandmaster election criterion for your network:
   a. Select Advanced > Timing tab.
   b. Use the Priority 1 field to define the first 8bit clock field.
c. Use the **Priority 2** field to define the backup 8bit clock field.

### Configuring the Video Delay and Audio Offset

The SDI Outputs options in the Timing tab enable you to adjust the timing of each SDI output independently. A SDI output may be timed relative to the incoming stream or PTP epoch time as follows:

- **When timed relative to the input stream**, the source will be delayed a fixed offset from the sender’s RTP timestamps. This allows for non-PTP aligned sources to be passed through with fixed latency.
- **When timed relative to the PTP epoch**, the SDI outputs will be aligned to the frame boundaries defined in SMPTE 2059-1, relative to the PTP epoch.

🌟 Use this procedure if you need to adjust the timing of each output independently. Otherwise it is recommended to keep these settings at the default values.

#### To adjust the timing for an SDI output

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “**To access the RAPTOR-IPG user interfaces in DashBoard**” on page 31.
2. Select **Advanced** > **Timing**.
3. Click **Outputs**.
   
   The **Timing** tab updates to display the timing options for each SDI output.

4. Locate the options for the SDI Output you want to adjust the timing for.
5. To automatically apply the default delay value of 2000us¹, select the **Default Delay** box for the output.
6. To manually configure the delay and offset values for an output:
   a. Verify that the SDI **Default Delay** box is cleared.
   b. Use the **Video Delay** slider to adjust the relative position of the video output start of frame as an offset to the reference.
   c. Use the **Audio Offset** slider to adjust the relative position of the audio start position as an offset to the reference.

---

¹ If the audio packet time is 1ms (1000us), the default video delay is 20000us and the audio delay is 20000us. If the audio packet time is 125us, the default video delay is 2000us and the audio delay is 2000us
Audio delay is specified relative to the video timing.

7. Click **Apply** to save the new settings.

8. Refresh the connection as follows:
   a. Select the **Receivers** tab.
   b. Locate the row for the output you need to refresh the connection for.
   c. Click **Disconnect**.
      
      The applicable **Output Status** field reports “Off” and the Destination SDI reads “Disconnected” for both the **Video** and **Audio** fields.
   d. Select the **Connections** tab.
   e. Locate the output you need to refresh the connection for.
   f. Click **Connect**.

### Setting the Audio Packet Time

You can add an offset to the audio streams if you suspect the audio packets may be received out of order or delayed. This enables the video stream to stay in sync with the audio stream.

Applying a new Audio Packet Time automatically removes all Sender and Destination audio streams. It is recommended to set the Audio Packet Time before configuring your audio streams.

**To set the audio packet time**

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “**To access the RAPTOR-IPG user interfaces in DashBoard**” on page 31.
2. Select **Advanced > Device Setup**.
3. Locate the **Device Settings** area of the tab.
4. Use the **Audio Packet Time** menu to specify the amount of time that RAPTOR-IPG will add as an offset to the audio streams.
5. Click **Apply**.
6. Verify that the audio streams have re-connected by viewing their status:
   a. Select the **Connections** tab.
   b. Locate the audio streams row in the Destinations area of the tab.
   c. Verify the read-only fields display “Connected”.
   d. If the audio streams do not automatically connect, navigate to the **Network Streams** tab and verify the settings for the audio streams.
Configuring the Receivers

Once you configure your Network Stream groups, you can connect each Network Stream to a Destination using the options in the Connections tab.

For More Information on...
- the assigning a Receiver to a Stream, refer to the chapter “Operation” on page 59.

Configuring a Receiver

Each configured Receiver enables the RAPTOR-IPG to advertise to Senders how much data it can receive and buffer.

To name a receiver
1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Select Advanced > Receivers.
3. Locate the row for the SDI signal you wish to configure.
4. Use the Name field to specify a unique identifier for the receiver.
   ✴ This identifier is used to help identify the receiver within your system and in the DashBoard Connections interface.

To assign an SFP to a receiver
1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Select Advanced > Receivers.
3. Use the SFP menu to assign the SDI signal to an SFP connection on the rear module.
4. Click to expand the monitoring options for the SDI signal.
5. Verify the source(s) for the SDI are correct and no errors are reported.
To verify the protection switching feature

1. Ensure the **ST 2022-7/Seamless Protection Switching** box is selected as outlined in the section “**Setting up Protection Switching**” on page 44.

2. Select **Advanced > Receivers**.

3. Locate the row for the SDI signal you wish to configure for protection switching.

4. Click the menu to expand the options.

   The **Protection Switching** options display as two separate rows under the SDI. In the example below, the button was selected for SDI 1.

   ![Protection Switching Options](image)

   Protection switching streams are assigned when a connection is made in the **Connections** tab. Refer to the section “**Routing the Signals**” on page 60 for more information.

**Using the Disconnect Button**

Clicking the **Disconnect** button for a session immediately stops that session and outputs black. This is helpful:

- to free up SFP bandwidth
- if the source is invalid or missing
- if the source includes data that you do not want to output
- to update the previous receiver with the latest settings (once the Disconnect button is clicked again)

**Assigning a Test Pattern to the SDI Output**

You can specify the type of internally generated test pattern to output.

**To assign a test pattern to an SDI output**

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “**To access the RAPTOR-IPG user interfaces in DashBoard**” on page 31.

2. Select **Advanced > PattGen**.
3. Locate the row for the SDI signal you wish to output a test pattern on.
4. Use the **Format** menu to specify the video format for the test pattern output.
5. Use the **Pattern** menu to specify the pattern to display on the output.
6. Select the **Enable** box to allow the SDI connection to output the test pattern.
7. Click **Apply** to save the new settings.
Configuring the Senders

For each SDI signal, you need to specify the IP encapsulation properties for the active video and audio.

Configuring the Active Video Properties

Before you begin, make a note of the **SFP Bandwidth Allocation** for the SFP ports to determine the available capacity on each port. This information is displayed in the top portion of the **Advanced > Senders > Active Senders** tab.

**To configure the active video properties for an SDI signal**

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “**To access the RAPTOR-IPG user interfaces in DashBoard**” on page 31.
2. Selected Advanced > Senders > Setup Streams.

3. Click Add Stream.
4. Use the Source Type to select Video.
   ✷ The Auto Create Audio Source button is now disabled.
5. Use the Source Name field to override the auto-detected name of the data stream with a unique identifier for the stream.
   ✷ This identifier is used to help identify the sender within your system and in the DashBoard Connections interface.
6. Use the NET menu to select the network interface used to transmit the data stream to the selected SFP port on the rear module.
   ✷ It is recommended to not edit the Transport IP, and UDP Port fields as these fields are auto-populated by the advertised stream.
7. Use the Select Video Source menu to assign an SDI input signal to the stream.
8. Click Apply to save the new settings.
Configuring the Active Audio Properties

Before you begin, make a note of the **SFP Bandwidth Allocation** for the SFP ports to determine the available capacity on each port. This information is displayed in the top portion of the **Advanced > Senders > Active Senders** tab.

**To configure the active video properties for an SDI signal**

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Selected **Advanced > Senders > Setup Streams**.
3. Click **Add Stream**.
4. Use the **Source Type** to select Audio.
   
   ✫ The **Select Video Source** menu is now read-only and the Audio Map displays at the bottom of the tab.

5. Use the **Source Name** field to override the auto-detected name of the data stream with a unique identifier for the stream.

   ✫ This identifier is used to help identify the sender within your system and in the DashBoard **Connections** interface.

6. Use the **NET** menu to select the network interface used to transmit the data stream to the selected SFP port on the rear module.

   ✫ It is recommended to not edit the **Transport IP**, and **UDP Port** fields as these fields are auto-populated by the advertised stream.

7. Click **Apply** to save the new settings.
8. Proceed to the next section.

**Mapping the Audio Channels to a Sender Stream**

You can choose to apply the default audio channel map or assign the channels as required by your system. Both methods are described in this section.
To map the audio channels to a sender stream using the default channel map

1. Click **Set Default Audio**.

   The **Audio Channels** map updates to display the default channel map.

   ✴ In the example below, the Audio Channel Count is set to 8, resulting in a target with 8 streams.

2. Click **Apply** to save the new settings.

To customize the audio channel mapping for a sender stream

✴ An audio channel can only be assigned to one sender.

1. In the **Audio Channels** map, select the channels to include in the audio stream.

   In the example below, the user selected channel **B1**.

2. In the **Target** map, select the sender channel to assign the audio channel to.

   In the example below, the user selected channel **A2**.
3. Click.

4. Click **Apply** to save the new settings.
Setting up the Network Streams

Once you have the Receivers and Senders configured on the RAPTOR-IPG, you must specify the available IP streams as network sessions for the RAPTOR-IPG.

Overview

You can configure a network source for the RAPTOR-IPG by assigning an advertised stream or adding a stream by manually specifying the IP stream credentials.

Advertised Streams

A network stream advertised by a node flows to multiple devices. The list of advertised RAVENNA streams available to the RAPTOR-IPG depends on the following card settings:

- Advanced > Timing > PTP
- Advanced > Setup > Transport Protocol

Manually Assigning a Stream

An IP stream can also be manually assigned as a network source for the RAPTOR-IPG. You will need the Transport IP Address, Port number, and DSCP value for the IP stream you want to add. This useful if you wish to access a network source that is not a RAVENNA device.

Adding a Network Stream

A network stream is identified in the Receivers and Connections tabs using the parameters specified in the Network Streams tab. Ensure to give each network source a unique name to ensure easy identification in DashBoard.

🌟 You cannot add a stream that is outside the range of 225.x.x.x to 239.x.x.x.

To add a new network source using an advertised stream

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Select the Network Streams tab.
3. Click **Add Group**.

   The fields in the **Network Streams** tab clear and the **Group Name** field displays “**NewGroup#**” where # is an auto-generated character.

4. Verify that the **Assign Manually** box is unselected (cleared).

5. Use the **Group Name** field to specify a unique identifier for the network source.

6. Use the **Advertised Stream** menu to specify the stream for the video and/or audio signals for the network source.

   The **Format**, **Transport IP**, **UDP Port**, and **# Ch** fields are read-only and automatically update when a new selection is made in the **Advertised Stream** menu.

7. Use the options in the **Group Category** area to assign the network source to a Connections category.

8. Click **Save** to update the list in the Network Streams tab.

**To add a new network source using a manually added stream**

1. Display the RAPTOR-IPG interfaces in Dashboard as outlined in the procedure “**To access the RAPTOR-IPG user interfaces in Dashboard**” on page 31.

2. Select the **Network Streams** tab.

3. Click **Add Group**.

   The fields in the **Network Streams** tab clear and the **Group Name** field displays “**NewGroup#**” where # is an auto-generated character.

4. Use the **Group Name** field to specify a unique identifier for the network source.

5. Select the **Assign Manually** box.

   The **Format**, **Transport IP**, **UDP Port**, and **# Ch** fields are now editable.

6. Use the **Format** field to specify the video format for the network source data.

7. Use the **Transport IP** field to specify the Multicast IP Address for the network source.

   ★ Only multicast IP Address of 239.x.x.x and 232.x.x.x can be received by the RAPTOR-IPG. Contact Ross Technical Support if you need additional IP ranges.

8. Use the **UDP Port** field to specify the RTP port for the advertised stream.

9. Use the **# Ch** field to specify the number of audio channels available in the specified stream.

10. Use the options in the **Group Category** area to assign the network source to a Connections category.

   ★ Assigning network sources to specific Categories enables you to filter the sources on the Connections tab.

11. Click **Save** to update the list in the Network Streams tab.

**To specify network streams for protection switching**

1. Ensure the **ST 2022-7/Seamless Protection Switching** box is selected as outlined in the section “**Enabling the Protection Switching Feature**” on page 36.

2. Add a new network stream as outlined in the procedure “**To add a new network source using a manually added stream**” on page 58.

   The **Protection Switching** options display as two separate rows.

3. Use the **Protection Switching** fields to assign the redundant video and audio streams to the RAPTOR-IPG.

4. Click **Save** to update the list in the Network Streams tab.
Operation

You can route the RAPTOR-IPG destinations and sources using the options in the Connections tab.

Connections Tab Overview

The Connections tab is organized into two areas: Destinations and Stream Sources.

![Example of a Populated Connections Tab](image)

**Figure 13.1 Example of a Populated Connections Tab**

1. **Destinations Area**
   
   This area displays the available destinations (outputs) in a series of rows. Each output is represented as a button which is clicked to include it in the routing switch. You can also assign the video, the video and audio, or just the audio, to the output. Video and Audio read-only fields report the Network Sources assigned to the output.

   A Status read-only field reports overall communication status, whether any error conditions are occurring on the SDI output, or in the network source.

2. **Stream Sources Area**
   
   This area displays the available inputs as selectable buttons. The options displayed here are determined by the network streams you configured via the Network Streams tab and the option selected in the **Show** menu.

Routing the Signals

To route the video and audio signals you must first select an SDI output, then a network source. Keep in mind that routing occurs automatically after a Source button is selected.

**To select an output**

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.

2. Select the **Connections** tab.

3. In the **Destinations** area, locate the button for the output you wish to route.

4. Click the required **Output** button.
To perform the switch

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.

2. Select the Connections tab.

A hot take is performed when a Receiver/Source pair is selected (the switch happens immediately as there is no Take button to select). The switch will include the video plus all associated audio, as specified in the Network Sources tab.

3. In the Stream Sources area, locate the button for the input (Network Stream) you wish to route.

4. Click the required Network Stream button to perform the switch.

Performing a Breakaway

A breakaway selects a source within a group to be switched. This allows the RAPTOR-IPG to route video from one network stream, and audio from another network stream.

If video is selected for a particular interface in the Destinations area and the selected Stream Group has a video stream, a video receiver is created on the destination. If audio is selected for a particular interface in the Destinations area and the selected Stream Group has an audio stream, an audio receiver is created on the destination.

To set up a breakaway

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.

2. Select the Connections tab.

3. Select the video to switch as follows:
   a. In the Destinations area, select the video field of the interface you wish to include.
   b. In the Stream Sources area, select the stream group you wish to route for video for this switch.

4. Select the audio to switch as follows:
   a. In the Destinations area, select the audio field of the interface you wish to include.
   b. In the Stream Sources area, select the stream group you wish to route for audio for this switch.
Ultritouch-2 Support

The Ultritouch-2 is a compact touchscreen panel that runs DashBoard and can be rack mounted or mounted at an operator’s desk for convenient access. Once the RAPTOR-IPG is configured and communication between the card and the panel is established, the Ultritouch-2 can be used to switch streams on the RAPTOR-IPG and monitor stream status.

* The RAPTOR-IPG does not support communications with an Ultritouch-4.

Connecting the openGear Frame and Ultritouch-2

Ultritouch-2 uses the open SLP protocol to locate devices on the same network as it is connected to. You must first set up communications between the openGear frame and the Ultritouch-2 panel before you access the RAPTOR-IPG interfaces, including the Connections window.

For More Information on...

- configuring and operating your Ultritouch-2, refer to the Ultritouch User Guide.

To set up a connection point between the openGear frame and Ultritouch-2

1. On the Ultritouch-2 panel, tap.

   * This button is located on the leftmost toolbar of the Ultritouch-2 interface.

2. Tap Connected Devices.

3. Tap Add.

4. Tap TCP/IP DashBoard Connect/openGear Device.

5. Use the Device IP/Hostname field to specify the IP Address for the openGear frame.

6. Use the Device Name field to specify the frame name.

7. Use the Protocol menu to specify whether the device communication language.

8. Use the Port field to specify the port on the device used for communicating with the frame.

9. Select the Remember connection settings for this device to retain the settings after a loss of communication.

10. Tap Add Device.

11. Select the frame from the Connected Devices table.

12. Tap Connect.

Accessing the RAPTOR-IPG Interfaces

It is recommended to use the DashBoard client software to setup and configure the RAPTOR-IPG and then use Ultritouch-2 for control via the Connections interface. Keep the following in mind when using Ultritouch-2 to control the RAPTOR-IPG:

- The Welcome and Initial Setup interfaces are not available on the Ultritouch-2 panel.

- The Connections window automatically displays each time the RAPTOR-IPG interface is loaded onto the Ultritouch-2 panel.

- The Connections window is re-organized when displayed on an Ultritouch-2 with the Destination buttons in the left most window, and the Sources on the right.
To display the RAPTOR-IPG on the Ultritouch-2 panel

1. On the Ultritouch-2 panel, tap .

   A list of devices communicating with the Ultritouch-2 displays.

2. Tap the icon for the openGear frame that houses the RAPTOR-IPG you want to access.
3. Tap the icon for the specific RAPTOR-IPG card you want to access.
4. Tap the icon for the menu you wish to display on the Ultritouch-2 panel.

   The Connections window for the selected RAPTOR-IPG automatically displays on the Ultritouch-2 panel.
Monitoring

The RAPTOR-IPG interface in DashBoard reports Ethernet bandwidth, stream health, and PTP communications status.

🌟 All alarms are enabled by default.

Monitoring the Receiver Streams

The Receivers tab reports read-only status information for each SDI signal. You can disable or enable the monitoring of specific SDI streams using the options in the Alarms tab.

**To monitor a specific receiver stream**

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Select Advanced > Receivers.
3. Locate the row for the SDI signal you wish to monitor.
4. Click in the required row to display the video and audio status fields for an SDI signal.

Notes on Monitoring the Receiver Streams

This section briefly summarizes possible RAPTOR-IPG behavior when monitoring a receiver stream.

**Receiver is configured to receive a stream, but the stream is absent**

When a stream is absent (i.e. never detected, or was lost for an extended period of time), the RAPTOR-IPG does not output any SDI frames and the SDI link will be inactive.

If a stream was present, but is no longer, the receiver will be in a state of “frame replay” where the RAPTOR-IPG continuously outputs the last frame received. This will continue until either the stream resumes (in which case, the valid video will start playing again), or the receiver is disconnected. If the stream is disconnected, the RAPTOR-IPG will stop outputting data.

**Receiver is not properly configured**

The RAPTOR-IPG will not output data before a receiver is configured (e.g. start-up condition).

**Tab is locked and displays an overlay message**

The RAPTOR-IPG lost connection to the PTP Clock and is attempting to re-connect. Once the RAPTOR-IPG can lock to the PTP Clock, the tab is unlocked. The following tabs are not locked during a loss of PTP clock connection:

- Status
- Ethernet I/O
- Timing
- Setup

Monitoring the Video Streams

DashBoard reports the following diagnostic information for each video stream:

- the video frame buffer fill level over time
- the pixel buffer fill level over time
- counters for missing packets, invalid packets, frame drops and frame replays
• memory (read/write) statistics
• current RTP timestamp alignment errors
• stream interrupts (such as pending missing markers and/or frame drops)

You can also specify what information to monitor for each stream and specify which stream(s) to monitor:
• any connected video stream can be monitored
• primary and redundant stream information is monitored individually

To view the video output statistics
1. Display the RAPTOR-IPG in DashBoard as outlined in “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Selected Advanced > Diagnostics.
3. Locate the Video Output Stream Diagnostics area.
4. From the Interface Select menu, specify the output you wish to monitor.
5. From the Stream Select menu, specify which network stream to monitor.

The Video Output Stream Diagnostics area updates to report information on the specified output and network stream. In the example below, the user selected SDI 3 for the output and Primary for the network stream.

6. To view the frame buffer levels or the pixel FIFO levels, scroll to the bottom of the tab.
Monitoring the Ethernet Status

DashBoard provides an estimate of the actual bandwidth of the 10G Ethernet links:

- all packets received on the 10G Ethernet links (media and processor traffic)
- transmit bandwidth (packets sent from the processor to the Ethernet links)
- receive bandwidth (packets sent on the 10G link and forward to the processor)

DashBoard also provides counters for the receive errors, transmit errors, packet size ranges, and general bytes.

To view the network diagnostic statistics

1. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
2. Selected Advanced > Diagnostics.
3. Click Show Network Diagnostics > OK.
Upgrading the Software

The RAPTOR-IPG can be upgraded in the field using the Ethernet port on the openGear frame and the options available in DashBoard.

To upgrade the software on a card

2. Ensure the Ethernet cable is connected to the Ethernet port on the openGear frame.
3. Display the RAPTOR-IPG interfaces in DashBoard as outlined in the procedure “To access the RAPTOR-IPG user interfaces in DashBoard” on page 31.
4. Select Upload, located near the bottom of the interface, to display the Select file Upload dialog.
5. Navigate to the *.bin file you want to upload.
6. Click Open.
7. If you are upgrading a single card:
   a. Click Finish.
   b. Proceed to step 9.
8. If you are upgrading multiple cards:
   a. Click Next > to display the Select Destination menu. This menu provides a list of the compatible cards.
   b. Specify the card(s) to upload the file to by selecting the check box(es) for the cards you want to upload the file to.
   c. Verify the card(s) you want to upload the file to. The Error/Warning fields indicate any errors, such as incompatible software or card type mismatch.
   d. Click Finish.
   e. Proceed to step 9.
9. Monitor the upgrade.
   • An Upload Status dialog enables you to monitor the upgrade process.
   • Notice that each card is listed in the dialog with a button. This button no longer displays once the upgrade completes.
   • The cards automatically reboot during the upgrade process.
   • The card(s) are temporarily taken off-line during the reboot process.
   • The process is complete once the status indicators for the Card State and Connection return to their previous status and the button no longer displays.
DashBoard Interface Overview

RAPTOR-IPG groups the configuration, monitoring, and operating features as a series of tabs in the DashBoard client window. This chapter summarizes the RAPTOR-IPG interfaces, tabs, menus, and parameters.

Welcome Tab

The Welcome tab displays on initial start-up of the RAPTOR-IPG in DashBoard. Once the initial settings are configured, hide this tab by selecting the required box on the Advanced > Device Setup tab and clicking Refresh.

![Example of the Welcome Tab](image)

Figure 17.1 Example of the Welcome Tab

Initial Setup Tab

The Initial Setup tab helps you to quickly set up your RAPTOR-IPG and proceed to configure your Network Streams and Connections. These controls are also available in the Advanced tabs (“Advanced Tabs” on page 73).

![Example of the Initial Setup Tab](image)

Figure 17.2 Example of the Initial Setup Tab
Connections Tab

The Connections tab is a patch-panel style interface that enables the RAPTOR-IPG to connect to available senders on the network. The tab is organized into two areas: Destinations and Stream Sources.

Destinations Area

The Destinations area is located at the top of the Connections tab and provides options for routing video and audio signals to the outputs on the RAPTOR-IPG. From this area you can quickly select outputs, and monitor the status of the output signals.

![Figure 17.3 Connections Tab — Example of the Destinations Area](image)

Table 17.1 summarizes the buttons, menus, and fields available in the Destinations area of the Connections tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>SDI #</td>
<td>Indicates the physical connection on the RAPTOR-IPG</td>
</tr>
<tr>
<td>Output Name</td>
<td>#</td>
<td>Each button represents an output that is configured and available for switching</td>
</tr>
<tr>
<td>Video (read-only)</td>
<td>#</td>
<td>Indicates the network stream currently used by the specified output</td>
</tr>
<tr>
<td>Audio (read-only)</td>
<td>#</td>
<td>Indicates the network stream currently used by the specified output</td>
</tr>
<tr>
<td>Status (read-only)</td>
<td>OK (Green)</td>
<td>No errors are detected on this output</td>
</tr>
<tr>
<td></td>
<td>Network Delay Too Big (Yellow)</td>
<td>The link offset selected by the user is smaller than the propagation delay of the network</td>
</tr>
<tr>
<td></td>
<td>No packets received (Yellow)</td>
<td>The configured destination IP stream(s) is not receiving any packets; stream might not be on the network or experiencing other issues</td>
</tr>
<tr>
<td></td>
<td>Not In Use (Gray)</td>
<td>This SDI output is disabled</td>
</tr>
<tr>
<td></td>
<td>System clock is in failure (Red)</td>
<td>The RAPTOR-IPG is unable to re-obtain a stable clock source. Sessions cannot be created until this condition is fixed. It is recommended to navigate to the Advanced &gt; Timing &gt; PTP tab to check the status of the PTP and update the Configuration settings. Once PTP is locked again, the Network Groups will need to be disconnected and then re-connected to clear the alarm.</td>
</tr>
</tbody>
</table>
Stream Sources Area

The Stream Sources area is located on the bottom half of the Connections tab. From this area you can route any source signal to an output, monitor its status, and filter the source available based on type.

Each button represents a configured network stream. You can filter what network streams are displayed via the Filter text field, the Category menu, or by selecting one of the Show: options.

![Figure 17.4 Connections Tab — Example of the Stream Sources Area](image)

- Once a Destination is selected, clicking a Stream Source button performs an immediate switch (a hot-punch).

Network Streams Tab

The Network Streams tab enables you to create and manage the IP streams in your system. There are two types of streams: advertised and manual. Advertised streams are those that the RAPTOR-IPG automatically detects as defined by the RAVENNA protocol. You can also define a stream by manually populating the Transport IP, Port, and DSCP fields for the video and audio signals. Once a network stream is defined, it is made available in the Connections tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status (read-only)</td>
<td>Param Out of Range (Red)</td>
<td>One of the following is occurring:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• a Destination has an invalid setting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• two receivers with the same network stream were created. The RAPTOR-IPG</td>
</tr>
<tr>
<td></td>
<td></td>
<td>can only subscribe to a stream once.</td>
</tr>
<tr>
<td>Connection (read-only)</td>
<td>Connection was successful</td>
<td>Indicates the connection status between the selected input and output.</td>
</tr>
<tr>
<td></td>
<td>Not in Use</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No Connection Information</td>
<td></td>
</tr>
<tr>
<td>Details</td>
<td></td>
<td>Opens the Details dialog that reports the state of the connection.</td>
</tr>
</tbody>
</table>
Table 17.2 outlines the options displayed in the Network Streams tab starting from the left-most area of the tab.

If the ST 2022-7/Seamless Protection Switching box is selected in the Setup tab, an extra Video row and an extra Audio row displays for Protection Switching setup for a stream.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure Receiver Network Stream Groups</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Group</td>
<td>Enables you to configure a new stream group</td>
<td></td>
</tr>
<tr>
<td>Remove Group</td>
<td>Deletes the selected group</td>
<td></td>
</tr>
<tr>
<td>Groups List</td>
<td>&lt;name&gt;</td>
<td>Lists the configured groups for the RAPTOR-IPG</td>
</tr>
<tr>
<td><strong>Group Category</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video</td>
<td></td>
<td>Assigns the stream to a type of data.</td>
</tr>
<tr>
<td>Audio</td>
<td></td>
<td>This is useful when filtering the streams on the Connections tab.</td>
</tr>
<tr>
<td>Camera</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microphone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Server</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Satellite</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Name</td>
<td>&lt;text&gt;</td>
<td>Specifies a unique identifier for the group</td>
</tr>
<tr>
<td># Audio Streams</td>
<td>#</td>
<td>Specifies the number of audio streams available in the stream group. The default value is 2.</td>
</tr>
<tr>
<td>Assign Manually</td>
<td>Selected</td>
<td>Enables you to manually enter the Transport IP, Port, and DSCP fields for a specific session. This is useful when accessing non-RAVENNA streams.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The Transport IP, Port, and DSCP fields are determined by the assigned Advertised Stream</td>
</tr>
</tbody>
</table>
The Advanced sub-tabs expand the controls available in the Initial Setup tab.

Status Tab

The Status tab provides read-only hardware information, signal status, and general product information for your RAPTOR-IPG. There are two sub-tabs: Device Status and SDI Inputs.

Device Status Tab

The tab is organized into four distinct areas in the DashBoard window: Alarms Summary, Product, Unsaved Changes, and Hardware.

### Table 17.2 Network Streams Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>#</td>
<td>Specifies the video format of the signal available for the stream</td>
</tr>
<tr>
<td>Advertised Network Streams</td>
<td></td>
<td>Lists the discovered RAVENNA sessions. Select a session to auto-fill the Video and/or Audio fields.</td>
</tr>
<tr>
<td>Video</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Audio #</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Manually Specified Streams</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stream Name</td>
<td>&lt;name&gt;</td>
<td>Assigns a unique identifier for the stream</td>
</tr>
<tr>
<td>Transport IP</td>
<td>#.#.#.#</td>
<td>Specifies the network socket for the video/audio data for the session. This value is auto-populated when you select an Advertised Stream.</td>
</tr>
<tr>
<td>UDP Port</td>
<td>#</td>
<td>Specifies the source port to connect to the advertised stream. This must match the source you are attempting to connect to.</td>
</tr>
<tr>
<td># Ch</td>
<td>#</td>
<td>Specifies the maximum number of audio channels in the specified stream</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click this button to display the Media Clock Offset field.</td>
</tr>
<tr>
<td>Audio Map</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Target</td>
<td></td>
<td>Use the audio map to assign audio channels, and determine their hierarchy, to an audio stream</td>
</tr>
<tr>
<td>Default Mapping</td>
<td>Selected</td>
<td>Applies a default audio mapping of 1:1 where:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Target 1-8 is mapped to A1-A8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Target 9-16 is mapped to B1-B8 etc.</td>
</tr>
<tr>
<td>Cleared</td>
<td></td>
<td>The default audio map is not applied; user can assign audio channels as required</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
<td>Click to display the audio map editing options</td>
</tr>
</tbody>
</table>

Advanced Tabs

The Advanced sub-tabs expand the controls available in the Initial Setup tab.
Table 17.3 summarizes the read-only information displayed in the Alarms Summary area.

**Table 17.3 Status Tab — Alarms Summary**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI Inputs Status</td>
<td></td>
<td>Reports the same information as the Advanced &gt; Status &gt; SDI Inputs status fields. Refer to Table 17.7 for more information.</td>
</tr>
<tr>
<td>Ethernet I/O -&gt; Control RJ-45 Status</td>
<td></td>
<td>Reports the same information as the Advanced &gt; Ethernet I/O &gt; Control RJ-45 &gt; Link Status field. Refer to Table 17.10 for more information.</td>
</tr>
<tr>
<td>Ethernet I/O -&gt; SFP Status</td>
<td></td>
<td>Reports the same information as the Advanced &gt; Ethernet I/O &gt; SFP # &gt; Link Status fields. Refer to Table 17.10 for more information.</td>
</tr>
<tr>
<td>Ethernet I/O -&gt; Special Multicast Configuration</td>
<td></td>
<td>Reports the same information as the Advanced &gt; Ethernet I/O &gt; Special Multicast Addresses fields.</td>
</tr>
<tr>
<td>Receivers -&gt; Stream Status</td>
<td></td>
<td>Reports the same information as the individual alarms in the Receivers tab. Refer to the section “Receivers Tab” on page 80.</td>
</tr>
<tr>
<td>Senders -&gt; Stream Status</td>
<td></td>
<td>Reports the same information as the Advanced &gt; Senders tab</td>
</tr>
<tr>
<td>Timing -&gt; System Clock Status</td>
<td></td>
<td>Reports the status of the PTP Clock connection</td>
</tr>
</tbody>
</table>

Table 17.4 summarizes the read-only information displayed in the Product area.

**Table 17.4 Status Tab — Product**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>RAPTOR-IPG</td>
<td>Indicates the product name of the hardware</td>
</tr>
<tr>
<td>Variant</td>
<td></td>
<td>Indicates the software marketing code</td>
</tr>
<tr>
<td>Supplier</td>
<td></td>
<td>Indicates the supplier/manufacturer of the device</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>#</td>
<td>Indicates the firmware version running on the card</td>
</tr>
</tbody>
</table>
Table 17.4 Status Tab — Product

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware Date</td>
<td>#</td>
<td>Indicates the build date of the firmware running on the card</td>
</tr>
<tr>
<td>FPGA Name</td>
<td>#.#</td>
<td>Indicates the FPGA version running on the card</td>
</tr>
<tr>
<td>FPGA Version</td>
<td>#</td>
<td>Indicates the assigned serial number of the card</td>
</tr>
</tbody>
</table>

Table 17.5 summarizes the read-only information displayed in the Unsaved Changes area.

Table 17.5 Status Tab — Unsaved Changes

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Setup Tab</td>
<td>Reports</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Device Setup tab</td>
</tr>
<tr>
<td>PattGen Tab Changes</td>
<td>Reports</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; PattGen tab</td>
</tr>
<tr>
<td>Senders -&gt; Setup Tab</td>
<td>Reports</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Senders &gt; Setup Stream tab</td>
</tr>
<tr>
<td>Discovery Tab Changes</td>
<td>Reports</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Discovery tab</td>
</tr>
<tr>
<td>Timing -&gt; PTP Tab</td>
<td>Reports</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Timing &gt; PTP tab</td>
</tr>
<tr>
<td>Timing -&gt; Outputs Tab</td>
<td>Reports</td>
<td>Reports if there are unsaved changes made to the Advanced &gt; Timing &gt; Outputs tab</td>
</tr>
</tbody>
</table>

Table 17.6 summarizes the read-only information displayed in the Hardware area.

Table 17.6 Status Tab — Hardware

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage (V)</td>
<td>#</td>
<td>Measured input voltage</td>
</tr>
<tr>
<td>Current (mA)</td>
<td>#</td>
<td>Current consumption in milliamperes</td>
</tr>
<tr>
<td>Power (W)</td>
<td>#</td>
<td>Indicates the calculated total power of the card</td>
</tr>
<tr>
<td>Daughter Card Voltage (V)</td>
<td>#</td>
<td>Indicates the measure input voltage of the Daughter Card</td>
</tr>
<tr>
<td>Daughter Card Current (mA)</td>
<td>#</td>
<td>Indicates the Current consumption in milliamperes of the Daughter Card</td>
</tr>
<tr>
<td>Daughter Card Power (W)</td>
<td></td>
<td>Indicates the calculated power of the Daughter Card</td>
</tr>
<tr>
<td>FPGA Temperature</td>
<td>#</td>
<td>Indicates the FPGA Core temperature</td>
</tr>
<tr>
<td>Installation Details</td>
<td>Displays</td>
<td>Displays additional Hardware status read-only fields</td>
</tr>
</tbody>
</table>
SDI Inputs Tab

The SDI Inputs tab reports status information on the SDI inputs of the rear module.

![Example of the Status > SDI Inputs Tab](image)

**Figure 17.7 Example of the Status > SDI Inputs Tab**

Table 17.7 summarizes the read-only information displayed in the SDI Inputs tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>OK (Green)</td>
<td>Indicates the SDI input signal is detected and valid</td>
</tr>
<tr>
<td></td>
<td>Audio Missing (Red)</td>
<td>Indicates one of the following is occurring:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• the SDI input signal is not detected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• the system frame rate does not match the input frame rate</td>
</tr>
<tr>
<td>Status</td>
<td>Unknown (Red)</td>
<td>Indicates the SDI input signal is not detected</td>
</tr>
<tr>
<td></td>
<td>Frame Rate Mismatch (Red)</td>
<td>Indicates the system frame rate does not match the input frame rate</td>
</tr>
<tr>
<td>Video</td>
<td>#</td>
<td>Indicates the video input signal format</td>
</tr>
<tr>
<td>Audio</td>
<td># channels, Sample rate: #</td>
<td>Indicates the number of audio groups that are present in the specified input signal, and the sample rate of the AES signal</td>
</tr>
<tr>
<td></td>
<td>Displays additional audio status information for the specified SDI input signal</td>
<td></td>
</tr>
</tbody>
</table>
Table 17.8 summarizes the read-only information displayed when the button is selected for an SDI row.

### Table 17.8 SDI Inputs Tab — SDI Inputs, Additional Information

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio CH #</td>
<td>Present</td>
<td>Indicates the specified audio channel is detected</td>
</tr>
<tr>
<td></td>
<td>No Signal</td>
<td>Indicates the specified audio channel is not available</td>
</tr>
</tbody>
</table>

Device Setup Tab

The **Device Setup** tab provides options to specify the device name, and transport options.

![Device Setup Tab](image)

Table 17.9 summarizes the options displayed in the Device Setup tab.

### Table 17.9 Device Setup Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Settings</td>
<td>Device Name &lt;text&gt;</td>
<td>Specifies a unique identifier for this RAPTOR-IPG. This name is used to identify the streams the RAPTOR-IPG is managing.</td>
</tr>
<tr>
<td></td>
<td>System Frame Rate Integer Rates (50, 60, 25)</td>
<td>Inputs, senders, and receivers must use a video format that matches this rate. This setting is updated and applied once PTP is locked.</td>
</tr>
<tr>
<td></td>
<td>System Frame Rate Non-Integer Rates (59.94, 29.97)</td>
<td>Adds an offset to the audio streams if you suspect the audio packets may be received out of order or delayed. This impacts all connected audio streams. Applying a new Audio Packet Time automatically disconnects all audio streams.</td>
</tr>
<tr>
<td>Audio Packet Time</td>
<td>#</td>
<td></td>
</tr>
</tbody>
</table>
**Table 17.9 Device Setup Tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Channel Count</td>
<td>#</td>
<td>Specifies the maximum number of audio channel available for configuration. The default is 8.</td>
</tr>
<tr>
<td>Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMPTE ST 2110-20 Payload Type</td>
<td>#</td>
<td>Specifies the 7bit numeric value that identifies the SMPTE 2110-20 RTP payload format the RAPTOR-IPG supports. The default is 98.</td>
</tr>
<tr>
<td>SMPTE ST 2110-30 Payload Type</td>
<td>#</td>
<td>Specifies the 7bit numeric value that identifies the SMPTE 2110-30 RTP payload format the RAPTOR-IPG supports. The default is 97.</td>
</tr>
<tr>
<td>Auto Generate Sender Multicast</td>
<td>Selected</td>
<td>Enables the RAPTOR-IPG to automatically assign a multicast address for any stream. This is the default.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>An IP Address must be specified for each stream</td>
</tr>
<tr>
<td>Reset All</td>
<td>Load Factory Reset</td>
<td>Sets certain editable card settings to the default values</td>
</tr>
</tbody>
</table>

**Dashboard Settings**

| Hide Welcome Tab                          | Selected   | The Welcome tab does not display in the Dashboard window                                            |
|                                            | Cleared    | The Welcome tab displays in the Dashboard window                                                     |

| Hide Initial Setup Wizard Tab             | Selected   | The Initial Setup tab does not display in the Dashboard window                                      |
|                                            | Cleared    | The Initial Setup tab displays in the Dashboard window                                              |

**Transport Options**

| SMPTE ST 2022-7 /Seamless Protection Switching | Selected   | Enables you to protect your streams by allowing the RAPTOR-IPG ports to carry a protection stream when operating in a redundant network |
|                                               | Cleared    | Disables this feature                                                                               |
| Transport Protocol (read-only)                | #          | Reports the standard used by the RAPTOR-IPG for video, audio, and clock synchronization               |

---

a. It is recommended to set the Audio Packet Time before configuring your audio streams.

**Ethernet I/O Tab**

Use the options in the Ethernet I/O tab to set the network settings for the 1GbE connection via the Network Controller card in the openGear frame, and the two SFP ports on the card rear module.
Table 17.10 summarizes the fields and menus displayed for configuring the network settings of the SFP ports and the RJ-45 port on the openGear frame.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Status (read-only)</td>
<td>OK (Green)</td>
<td>The link for the Network Controller Card is valid</td>
</tr>
<tr>
<td></td>
<td>Link Down (Red)</td>
<td>The link for the Network Controller Card is invalid (fails)</td>
</tr>
<tr>
<td>Current IP (read-only)</td>
<td>#.#.#.#</td>
<td>Indicates the IP Address currently assigned to the card</td>
</tr>
<tr>
<td>MAC Address (read-only)</td>
<td>#</td>
<td>Indicates the MAC Address currently assigned to the card</td>
</tr>
<tr>
<td>Mode</td>
<td>Static</td>
<td>The user manually supplies the network settings for the card</td>
</tr>
<tr>
<td></td>
<td>DHCP</td>
<td>Automates the assignment of the network settings for the card</td>
</tr>
<tr>
<td>Static IP Address</td>
<td>###.#.#.#.#.#</td>
<td>Specifies the static IP Address for the card the user wants to manually assign</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>#.#.#.#</td>
<td>The subnet mask for the card</td>
</tr>
<tr>
<td>Gateway</td>
<td>#.#.#.#</td>
<td>The gateway for communications outside of the local area network (LAN)</td>
</tr>
</tbody>
</table>

Status Area

Table 17.11 summarizes the read-only fields displayed for each SFP port.
The Receivers tab provides details on each of the IP receivers of the RAPTOR-IPG. The Receivers tab is organized into two sub-tabs: Status and X-Connect.

**Status Tab**

The top of the Status tab displays a read-only field for each available SFP on the RAPTOR-IPG rear module. These fields report the bandwidth allocated by the Receiver SFP port.

* The value displayed within each bar indicates the port utilization by the active receivers.

---

### Table 17.11 Ethernet I/O — Status

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature (Celsius)</td>
<td>#</td>
<td>Internal temperature as reported by the specified SFP port</td>
</tr>
<tr>
<td>Wavelength (nm)</td>
<td>#</td>
<td>Indicates the transmitted wavelength</td>
</tr>
<tr>
<td>Part Number</td>
<td>#</td>
<td>Indicates the part number of the module installed in the specified SFP port</td>
</tr>
<tr>
<td>RX Bandwidth Used</td>
<td>#</td>
<td>Reports the amount of data the RAPTOR-IPG is currently receiving on the specified SFP port</td>
</tr>
<tr>
<td>TX Bandwidth Used</td>
<td>#</td>
<td>Reports the amount of data the RAPTOR-IPG is currently transmitting on the specified SFP port</td>
</tr>
</tbody>
</table>

**Special Multicast Addresses**

Configure Special Multicast Address

Click **Configure** to display the Configure Multicast Whitelist dialog. The dialog includes the items listed below.

| IP Address | # (read-only) | The addresses 225.1.1.1, 239.255.255.255, and 239.255.255.253 are automatically added to the whitelist as read-only entries |
| Mask       | # (read-only) | Specifies the Mask value for the read-only Multicast Whitelist IP Addresses |
| Status     | Enabled      | Indicates the specified network stream is added to the whitelist and cannot be used as a network stream for a receiver or sender |
|            | Disabled     | Indicates the specified network stream is added to the whitelist but is currently available as a network stream that can be assigned to a receiver or sender |

Add Creates a new entry in the whitelist

Remove Deletes the entry from the whitelist

Enable Keeps the entry but adds it to the allowed IP Addresses that are made available to the RAPTOR-IPG. If an IP Address is enabled as a whitelist entry, then it cannot be used as an audio or video stream.
If the bandwidth bar is green, the allocated bandwidth is just below 100%.

The SDI Receiver area of the tab, located at the bottom, reports each SDI as a row in the tab and provides the items and parameters.

Table 17.12 outlines the read-only fields and menus available to configure the receiver settings for each SDI.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status (read-only)</td>
<td>OK (Green)</td>
<td>No errors are detected on this SDI connection</td>
</tr>
<tr>
<td></td>
<td>Network Delay Too Big</td>
<td>The link offset selected by the user is smaller than the propagation delay of the network</td>
</tr>
<tr>
<td></td>
<td>(Yellow)</td>
<td></td>
</tr>
<tr>
<td>Status (read-only)</td>
<td>No packets received</td>
<td>The configured receiver IP stream(s) is not receiving any packets; stream might not be on the network or experiencing other issues</td>
</tr>
<tr>
<td></td>
<td>(Yellow)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not in Use (Gray)</td>
<td>This SDI connection is disabled</td>
</tr>
<tr>
<td></td>
<td>PTP Unstable, try again</td>
<td>The RAPTOR-IPG is unable to obtain a stable clock source. Sessions cannot be created until this condition is fixed.</td>
</tr>
<tr>
<td></td>
<td>(Red)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>It is recommended to navigate to the Timing &gt; PTP tab to check the status of the PTP and update the Configuration settings.</td>
</tr>
<tr>
<td></td>
<td>Param Out of Range (Red)</td>
<td>One of the following is occurring:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Two receivers with the same network source were created. RAPTOR-IPG can only subscribe to a stream once</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The wrong format is detected</td>
</tr>
<tr>
<td>Name</td>
<td>&lt;text&gt;</td>
<td>Assigns an unique identifier to the receiver stream</td>
</tr>
</tbody>
</table>
Table 17.13 summarizes the information that displays when the button is selected at the end of a row.

### Table 17.13 Receivers Tab — Additional Status

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status (read-only)</td>
<td>OK (Green)</td>
<td>No errors are detected on the video signal</td>
</tr>
<tr>
<td></td>
<td>Not in Use (Gray)</td>
<td>This SDI video stream is disabled</td>
</tr>
<tr>
<td>Source Name</td>
<td>xx.yy.video</td>
<td>The source name is determined by the stream that is connected</td>
</tr>
<tr>
<td>Transport IP</td>
<td>#</td>
<td>Specifies the IP Address for the video session</td>
</tr>
<tr>
<td></td>
<td>&lt;blank&gt;</td>
<td>The card firmware provides an IP when the session is created</td>
</tr>
<tr>
<td>Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the video essence</td>
</tr>
<tr>
<td>SFP</td>
<td>#</td>
<td>Indicates the SFP port on the rear module that the video signal is derived from</td>
</tr>
<tr>
<td>Link Offset (us)</td>
<td>#</td>
<td>Reports the Video Delay value set in the Timing &gt; SDI Outputs tab for the SDI output</td>
</tr>
<tr>
<td><strong>Audio #</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>OK (Green)</td>
<td>No errors are detected on the audio signal</td>
</tr>
<tr>
<td></td>
<td>Not in Use (Gray)</td>
<td>The audio channels are disabled or unavailable</td>
</tr>
<tr>
<td>Source Name</td>
<td>xx.yy.audio#</td>
<td>The source name is determined by the stream that is connected</td>
</tr>
<tr>
<td>Transport IP</td>
<td>#</td>
<td>Specifies the IP Address for the audio session</td>
</tr>
<tr>
<td></td>
<td>&lt;blank&gt;</td>
<td>The card firmware provides an IP when the session is created</td>
</tr>
<tr>
<td>Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the audio essence</td>
</tr>
</tbody>
</table>

Table 17.13 summarizes the information that displays when the button is selected at the end of a row.
X-Connect Tab

The **X-Connect** tab provides read-only details on the audio mapping of the current audio receiver session(s). Table 17.14 outlines the Receiver Audio Mapping read-only fields on the X-Connect tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFP (read-only)</td>
<td>#</td>
<td>Indicates the SFP port on the rear module that the audio signal is derived from</td>
</tr>
<tr>
<td>Link Offset (us)</td>
<td>#</td>
<td>Reports the Audio Offset and/or Audio Delay values set in the Timing &gt; SDI Outputs tab for the SDI output</td>
</tr>
</tbody>
</table>

**Table 17.14 Receivers > X-Connect Tab**

PattGen Tab

The PattGen tab provides options for independently configuring a pattern generator for each SDI output. (Figure 17.12)
Table 17.15 summarizes the options displayed in the PattGen tab.

### Table 17.15 PattGen Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>Selected</td>
<td>The specified output outputs the test pattern assigned using the Pattern menu</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables the pattern generator for the specified output</td>
</tr>
<tr>
<td>Format</td>
<td>#</td>
<td>Specifies the video format for the pattern generator</td>
</tr>
<tr>
<td>Pattern</td>
<td>Colorbar 100% Pattern</td>
<td>Specifies the type of test pattern to output.</td>
</tr>
<tr>
<td></td>
<td>Colorbar 75% Pattern</td>
<td>Note that the test pattern replaces all of the output picture but not the HANC, while the VANC is blanked</td>
</tr>
<tr>
<td></td>
<td>Pathological Pattern</td>
<td></td>
</tr>
</tbody>
</table>

**Senders Tab**

The **Senders** menus are organized into two sub-tabs: Active Streams and Setup Streams.

**Active Streams Tab**

The **Active Streams** tab reports the SFP bandwidth utilization. If a bandwidth bar is green, the allocated bandwidth is below 75%.

![Figure 17.13 Senders Tab — Example of an SFP Bandwidth Allocation Status Area](image)

Table 17.16 lists the fields that display below the SFP Bandwidth Utilization area on the tab.

### Table 17.16 Senders — Active Streams Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video Streams</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>&lt;text&gt;</td>
<td>Provides a unique identifier for the video data available on the specified SDI input</td>
</tr>
<tr>
<td>Status (read-only)</td>
<td>OK (Green)</td>
<td>The sender streams are operating correctly without errors</td>
</tr>
<tr>
<td></td>
<td>Apply Changes (Yellow)</td>
<td>One or more settings were changed on the Setup Streams tab. You must click <strong>Apply</strong> to update the settings on the RAPTOR-IPG.</td>
</tr>
</tbody>
</table>
### Table 17.16 Senders — Active Streams Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status (read-only)</td>
<td>PTP Unstable, try again (Red)</td>
<td>The RAPTOR-IPG is unable to obtain a stable clock source. Sessions cannot be created until this condition is fixed. It is recommended to navigate to the Advanced &gt; Timing &gt; PTP tab to check the status of the PTP and update the Configuration settings.</td>
</tr>
<tr>
<td>Param Out of Range (Red)</td>
<td></td>
<td>One of the following is occurring: • a sender was configured with an invalid setting. • two senders with the same network source were created. The RAPTOR-IPG can only subscribe to a stream once.</td>
</tr>
<tr>
<td>SDI Not Present (Red)</td>
<td></td>
<td>A valid SDI signal is not detected on the specified SDI BNC of the RAPTOR-IPG.</td>
</tr>
<tr>
<td>Marked for Removal (Red)</td>
<td></td>
<td>The user has disabled the sender but has not clicked the Apply button yet.</td>
</tr>
<tr>
<td>Transport IP</td>
<td>#.#.#.#</td>
<td>Specifies the IP Address for the video session.</td>
</tr>
<tr>
<td>UDP Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the video.</td>
</tr>
<tr>
<td>SFP</td>
<td>#</td>
<td>Indicates the SFP port the specified sender stream is assigned to.</td>
</tr>
<tr>
<td>Pause</td>
<td></td>
<td>• Pauses the video stream from sending • The button label changes to Resume</td>
</tr>
<tr>
<td>Remove</td>
<td></td>
<td>• Removes the video stream from the current session. Note that the stream is not removed from the Setup Streams tab. • The Setup Streams tab now reports the “Not Active” error message</td>
</tr>
</tbody>
</table>

**Audio Streams**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>&lt;text&gt;</td>
<td>Provides a unique identifier for the audio channels available on the specified SDI input</td>
</tr>
<tr>
<td>Status (read-only)</td>
<td></td>
<td>Reports the audio activity of the session</td>
</tr>
<tr>
<td>Transport IP</td>
<td>#.#.#.#</td>
<td>Specifies the IP Address for the audio session</td>
</tr>
<tr>
<td>UDP Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the audio essence</td>
</tr>
<tr>
<td>SFP</td>
<td>#</td>
<td>Indicates the SFP port the specified sender stream is assigned to.</td>
</tr>
<tr>
<td>Pause</td>
<td></td>
<td>• Pauses the audio stream from sending • The button label changes to Resume</td>
</tr>
<tr>
<td>Remove</td>
<td></td>
<td>• Removes the audio stream from the current session. Note that the stream is not removed from the Setup Streams tab. • The Setup Streams tab now reports the “Not Active” error message</td>
</tr>
</tbody>
</table>

---

a. When the sender is first enabled, the streams are named using the nomenclature: systemdevicename.sendername.video.
Setup Streams Tab

The Setup Streams tab allows you to configure the sender streams for the RAPTOR-IPG. The configuration options in the Setup Streams tab provides options for enabling, re-naming, selecting the source, and the communication settings for each SFP.

![Figure 17.14 Senders — Setup Streams Tab](image)

Table 17.17 summarizes the menus and fields available in the Setup Streams tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Stream</td>
<td>Creates a new entry in the Senders list</td>
<td></td>
</tr>
<tr>
<td>Remove Stream</td>
<td>Deletes the entry from the Senders list</td>
<td></td>
</tr>
<tr>
<td>Connection Status</td>
<td>Indicates whether the stream assigned to this sender group is active or not</td>
<td></td>
</tr>
<tr>
<td>Source Type</td>
<td>Video, Audio</td>
<td>Specifies the type of data that the new stream will transport</td>
</tr>
<tr>
<td>Source Name</td>
<td>&lt;text&gt;</td>
<td>Provides a unique identifier for the SDI input signal. This name is used to identify the data within your network.</td>
</tr>
<tr>
<td>NET</td>
<td>Auto</td>
<td>The RAPTOR-IPG automatically selects the available SFP port for the sender stream</td>
</tr>
<tr>
<td>SFP #</td>
<td>Assigns the specified SFP port to the sender stream</td>
<td></td>
</tr>
<tr>
<td>Transport IP</td>
<td>#</td>
<td>Specifies the IP Address for the primary stream of this session</td>
</tr>
<tr>
<td></td>
<td>&lt;blank&gt;</td>
<td>If the Device Setup &gt; Allow Random IP box is selected, the RAPTOR-IPG firmware provides an IP when the session is created.</td>
</tr>
<tr>
<td>UDP Port</td>
<td>#</td>
<td>Indicates the port associated with the IP address and the communication protocol for the primary stream</td>
</tr>
</tbody>
</table>
Discovery Tab

The Discovery tab provides options for configuring communications via the supported protocols.

Table 17.18 summarizes the options displayed in the Discovery tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMOS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device Name</td>
<td>&lt;text&gt;</td>
<td>Assigns a unique identifier for the card when communicating with NMOS-based devices</td>
</tr>
<tr>
<td>Use System Device Name</td>
<td></td>
<td>Applies the identifier to the card as assigned by the master NMOS device</td>
</tr>
<tr>
<td>Node Name</td>
<td>&lt;text&gt;</td>
<td>Name of the NMOS node being advertised</td>
</tr>
<tr>
<td>Enable</td>
<td>Selected</td>
<td>The RAPTOR-IPG is available as a NMOS device</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The RAPTOR-IPG is unavailable as a NMOS device</td>
</tr>
</tbody>
</table>
### Table 17.18 Discovery Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>openGear Chassis RJ-45</td>
<td>The RAPTOR-IPG uses the uses the RJ-45 port on the openGear frame for NMOS communications</td>
</tr>
<tr>
<td>SFP #</td>
<td></td>
<td>The RAPTOR-IPG uses the specified SFP port on the rear module for NMOS communications</td>
</tr>
<tr>
<td>All</td>
<td></td>
<td>The RAPTOR-IPG accepts NMOS requests via the RJ-45 port on the frame and all SFP ports</td>
</tr>
<tr>
<td>SDP Port (read-only)</td>
<td>#</td>
<td>Specifies the SDP HTTP port used to GET SDPS</td>
</tr>
<tr>
<td>Node Port (read-only)</td>
<td>#</td>
<td>Specifies the port the NMOS IS-04 Node service is listening on</td>
</tr>
<tr>
<td>Query Port (read-only)</td>
<td>#</td>
<td>Specified the port the NMOS IS-04 Query service is listening on</td>
</tr>
</tbody>
</table>

**RAVENNA**

| Board Name                  | <text>         | Assigns a unique identifier for the RAPTOR-IPG when communicating with RAVENNA-based devices |
| Use System Device Name      |                | Applies the identifier to the RAPTOR-IPG as assigned by the master RAVENNA device |
| Interface                   | openGear Chassis RJ-45 | The RAPTOR-IPG uses the RJ-45 port on the openGear frame for RAVENNA communications |
| SFP #                       |                 | The RAPTOR-IPG uses the specified SFP port on the rear module for RAVENNA communications |
| All                         |                 | The RAPTOR-IPG accepts RAVENNA requests via the RJ-45 port on the frame, and all SFP ports |
| Port                        | #              | Specifies the communications port on the network that the RAPTOR-IPG uses for RAVENNA communications. The default is 80. |

**RTSP**

| Interface                   | openGear Chassis RJ-45 | The RAPTOR-IPG uses the RJ-45 port on the openGear frame for RTSP communications |
| SFP #                       |                 | The RAPTOR-IPG uses the specified physical SFP port for RTSP communications |
| All                         |                 | The RAPTOR-IPG accepts RTSP requests via the RJ-45 port on the frame, and all SFP ports |
| Port                        | #              | Specifies the TCP port the protocol uses to send and receive messages. The default is 8554. |

**Ember+**

| Port                        | #              | Specifies the communications port on the network that the RAPTOR-IPG uses for Ember+ communications. The default is 9095. |
Timing Tabs

The system timing options for the card are organized into the following tabs displayed on the Timing tab: PTP, and Outputs.

PTP Tab

Use the PTP tab to configure the PTP client settings for RAPTOR-IPG. This is where RAPTOR-IPG is pointed to an active Grandmaster.

Table 17.19 summarizes the options displayed in the PTP tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Enable</td>
<td>Selected</td>
<td>The NEWT will use the Session Announcement Protocol (SAP) to broadcast multicast session information</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables this feature</td>
</tr>
</tbody>
</table>

**Table 17.19 Timing Tab — PTP**
### Table 17.19 Timing Tab — PTP

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile</td>
<td>IEE1588:Default</td>
<td>Specifies the RAPTOR-IPG timing uses IEE1588 standard</td>
</tr>
<tr>
<td></td>
<td>AES67:Media</td>
<td>Specifies the RAPTOR-IPG timing uses AES67: Media standard</td>
</tr>
<tr>
<td></td>
<td>SMPTE:2059-2</td>
<td>Specifies the RAPTOR-IPG timing uses SMPTE 2059-2 standards. This is the recommended setting.</td>
</tr>
<tr>
<td>Custom PTP Profile</td>
<td>Selected</td>
<td>The Domain, Priority1, Priority2, Role status, Sync Interval, Announce Interval and Announce Receipt Timeout fields can be edited to create a custom PTP profile</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>The Domain, Priority1, Priority2, Role status, Sync Interval, Announce Interval and Announce Receipt Timeout fields are set to the default values of the selected PTP Profile.</td>
</tr>
<tr>
<td>Domain</td>
<td>#</td>
<td>Specifies that the card is within the specified group of clocks in your network</td>
</tr>
<tr>
<td>Priority1</td>
<td>#</td>
<td>Assigns the first priority level to the card during a Grandmaster election where a value of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1 is the highest priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 255 is the lowest priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This menu is applicable when the Slave Only box is not selected</td>
</tr>
<tr>
<td>Priority2</td>
<td>#</td>
<td>Assigns the secondary priority level to the card during a Grandmaster election where a value of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1 is the highest priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 255 is the lowest priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This menu is applicable when the Slave Only box is not selected</td>
</tr>
<tr>
<td>SFP #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Role Status (read-only)</td>
<td>#</td>
<td>Indicates the role that the specified port is assigned to in the network system</td>
</tr>
<tr>
<td>Sync Interval</td>
<td># ms</td>
<td>Specifies how often the SFP port on the RAPTOR-IPG sends Sync messages</td>
</tr>
<tr>
<td>Announce Interval</td>
<td># ms</td>
<td>Specifies how often the SFP port on the RAPTOR-IPG sends Announce messages</td>
</tr>
<tr>
<td>Announce Receipt Timeout</td>
<td>#</td>
<td>Controls how long the SFP port on the RAPTOR-IPG will wait before declaring the Grandmaster absent and initiating a new election</td>
</tr>
<tr>
<td>Status (read-only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Reference</td>
<td>PTP SLAVE</td>
<td>Specifies that the RAPTOR-IPG is a Slave; using that system clock as the reference</td>
</tr>
<tr>
<td></td>
<td>INTERNAL</td>
<td>Specifies that the RAPTOR-IPG is a master; using that system clock as the reference</td>
</tr>
</tbody>
</table>
The Outputs tab enables you to adjust the timing of each SDI output. Table 17.20 summarizes the options displayed in the SDI Outputs tab for each SDI.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Status</td>
<td>Locked</td>
<td>Status of PTP on the system</td>
</tr>
<tr>
<td></td>
<td>Free run</td>
<td></td>
</tr>
<tr>
<td>Interface Status</td>
<td>Locked</td>
<td>Status of PTP on the interface</td>
</tr>
<tr>
<td></td>
<td>Acquiring</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fail</td>
<td></td>
</tr>
<tr>
<td>Details</td>
<td></td>
<td>Reports details on detected Start of Frame (SOF) errors; a Locked Counter field reports the number of times the PTP connection was unlocked.</td>
</tr>
</tbody>
</table>

**Local (read-only)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ID</td>
<td>#</td>
<td>Reports the ID number assigned to the RAPTOR-IPG within the system</td>
</tr>
<tr>
<td>Mean Path Delay (ns)</td>
<td>#</td>
<td>Average time in nanoseconds it takes a packet to traverse end to end from the PTP master</td>
</tr>
<tr>
<td>Offset From Master (ns)</td>
<td>#</td>
<td>Correction time offset from the master in nanoseconds</td>
</tr>
<tr>
<td>Min Delay Request Interval</td>
<td>#</td>
<td>Specifies how long the RAPTOR-IPG will wait for a delay request</td>
</tr>
</tbody>
</table>

**Grandmaster**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grandmaster ID</td>
<td>#</td>
<td>Reports the ID number assigned to the Grandmaster within the system</td>
</tr>
<tr>
<td>Priority1</td>
<td>#</td>
<td>Standard PTP fields used to determine who wins a PTP election</td>
</tr>
<tr>
<td>Priority2</td>
<td>#</td>
<td></td>
</tr>
<tr>
<td>Clock Accuracy</td>
<td>#</td>
<td>Standard PTP field that states the accuracy of the system clock on the system</td>
</tr>
<tr>
<td>Clock Class</td>
<td>#</td>
<td>Standard PTP field that states the class of the clock used on the system</td>
</tr>
</tbody>
</table>

**Show Advanced PTP Stats**

Click this button to display read-only fields and an active graph that maps the RMS (average offset from master over time). Use the **Configure Trigger Threshold** dialog to set an alarm when a specified threshold is reached.

**Outputs Tab**

The Outputs tab enables you to adjust the timing of each SDI output. Table 17.20 summarizes the options displayed in the SDI Outputs tab for each SDI.
Alarms Tab

The **Alarms** tab enables you to manage the type of alarms the RAPTOR-IPG reports.

- All alarms are enabled by default.

### Table 17.20 Timing Tab — SDI Outputs

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Delay</td>
<td>Selected</td>
<td>The default for audio and video delays change based on the audio packet time set on the device. If the audio packet time is 1ms (1000us) to default video delay is 20000us and audio delay is 20000us. If the audio packet time is 125us to default video delay is 2000us and audio delay is 2000us.</td>
</tr>
<tr>
<td>Cleared</td>
<td></td>
<td>RAPTOR-IPG applies the delay and offset settings in the Outputs tab for the specified signal.</td>
</tr>
<tr>
<td>Video Delay</td>
<td>#</td>
<td>Sets the video output delay relative to the selected reference.</td>
</tr>
<tr>
<td>Audio Offset</td>
<td>#</td>
<td>Changes the link offset values used when a receiver is setup.</td>
</tr>
<tr>
<td>Audio Delay (us)</td>
<td>#</td>
<td>Reports the audio output delay (Video Delay value + Audio Offset value) relative to the selected reference.</td>
</tr>
<tr>
<td>(read-only)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Figure 17.17 Alarms Tab](image)

Table 17.21 summarizes the options displayed in the Alarms tab.
### Table 17.21 Alarms Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Receiver Streams - SDI #</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Stream</td>
<td>Selected</td>
<td>Enables the monitoring of the video stream. The status is reported in the Destinations area of the Connections tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of this stream</td>
</tr>
<tr>
<td>Audio Stream</td>
<td>Selected</td>
<td>Enables the monitoring of the audio stream. The status is reported in the Destinations area of the Connections tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of this stream</td>
</tr>
<tr>
<td><strong>Sender Streams - Primary, Protection Switching</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Stream</td>
<td>Selected</td>
<td>Enables the monitoring of the video stream. The status is reported in the Sender tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of this stream</td>
</tr>
<tr>
<td>Audio Stream</td>
<td>Selected</td>
<td>Enables the monitoring of the audio signal of the stream The status is reported in the Sender tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of this stream</td>
</tr>
<tr>
<td><strong>Sender Setup - Status</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Selected</td>
<td>Changes made to the Advanced &gt; Senders &gt; Setup Streams tab are reported in the Advanced &gt; Status &gt; Device tab</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of the menus on the Advanced &gt; Senders tab. The Senders Status and Changes field in the Advanced &gt; Device tab does not report any issues.</td>
</tr>
<tr>
<td><strong>SDI Inputs - SDI #</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Missing</td>
<td>Selected</td>
<td>Enables the monitoring of the video signal of the specified SDI input. If the video signal is not detected, an error message displays in the Input Status tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of the SDI video input</td>
</tr>
<tr>
<td>Audio Missing</td>
<td>Selected</td>
<td>Enables the monitoring of the audio signal of the specified SDI input. If the audio signal is not detected, an error message displays in the Input Status tab.</td>
</tr>
<tr>
<td></td>
<td>Cleared</td>
<td>Disables monitoring of the SDI audio input</td>
</tr>
<tr>
<td><strong>Ethernet I/O - openGear Chassis RJ-45</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Logs tab is organized into two sub-tabs: System Log and Captures.

System Log Tab
The System Log tab provides a system log interface that reports tasks, messages, and other operating information in a table format. This is useful when troubleshooting with the help of Ross Technical Support.

Captures Tab
The Captures tab displays a list of log entries that were captured.

Table 17.22 summarizes the options displayed in the Captures tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>&lt;text&gt;</td>
<td>Lists the recent debug, core, and PCAP files currently available for download. Select the Refresh button in the top right corner to update the list.</td>
</tr>
<tr>
<td>Size (bytes)</td>
<td>#</td>
<td>Indicates the size of the file</td>
</tr>
<tr>
<td>Request Debug</td>
<td></td>
<td>Creates a file that captures the log entries and device status information of the RAPTOR-IPG</td>
</tr>
<tr>
<td>Duration [s]</td>
<td>#</td>
<td>Specifies the length of time (in seconds) to perform a packet capture (PCAP)</td>
</tr>
<tr>
<td>Packet Capture</td>
<td></td>
<td>Captures a PCAP file on the port specified in the Interface menu</td>
</tr>
</tbody>
</table>
Diagnostics Tab

The Diagnostics tab provides additional read-only information to help troubleshoot the network communication activity, and the video output stream status.

Network Diagnostics

This section summarizes the Network Diagnostics fields that are displayed after the Show Network Diagnostics button is selected.

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface eth0</td>
<td></td>
<td>Captures a PCAP file for the openGear RJ45 port of the RAPTOR-IPG</td>
</tr>
<tr>
<td>Interface eth1</td>
<td></td>
<td>Captures a PCAP file for the SFP 1 port of the RAPTOR-IPG</td>
</tr>
<tr>
<td>Interface eth2</td>
<td></td>
<td>Captures a PCAP file for the SFP 2 port of the RAPTOR-IPG</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Diagnostics - SFP # &gt; Link Statistics</td>
<td></td>
<td>Reports the total number of error packets which are received on the specified SFP port</td>
</tr>
<tr>
<td>Rx Errors</td>
<td>#</td>
<td>Reports the total number of error packets which are transmitted on the specified SFP port</td>
</tr>
<tr>
<td>Rx Bandwidth</td>
<td>#</td>
<td>Reports the amount of data the RAPTOR-IPG is currently receiving on the specified SFP port</td>
</tr>
</tbody>
</table>
The Video Output Stream Diagnostics area can display the following information for any video stream:

- A graph of the Video Frame Buffer Fill level over time (with maximum and minimum levels indicated separately)
- A graph of the Pixel FIFO Fill level over time (with maximum and minimum levels indicated separately)
- A running count of missing packets, invalid packets, frame drops, frame replays
- A current view of memory statistics such as a read/write counter, the read/write pointers, the RTP timestamp alignment errors, and a view of per-stream interrupts (such as pending missing markers, and pending frame drops)

Any connected video stream can be monitored when they are connected. If disconnected, the video stream is also removed from the monitoring list in this tab.

The Video Output Stream Diagnostics area of the tab enables you to specify the SDI output and type of stream to monitor. **Figure 17.19** shows an example where the user is monitoring the video stream on SDI 1.

### Table 17.23 Diagnostics Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx Bandwidth</td>
<td>#</td>
<td>Reports the amount of data the RAPTOR-IPG is currently transmitting on the specified SFP port</td>
</tr>
<tr>
<td>Network Diagnostics - SFP # &gt; CPU Statistics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rx Errors</td>
<td>#</td>
<td>Reports the total number of errors packets received on the 10G link</td>
</tr>
<tr>
<td>Tx Errors</td>
<td>#</td>
<td>Reports the total number of errors packets sent on the 10G link</td>
</tr>
<tr>
<td>Rx Bandwidth</td>
<td>#</td>
<td>Reports the packets received on the 10G link and forwarded to the processor on the specified SFP port</td>
</tr>
<tr>
<td>Tx Bandwidth</td>
<td>#</td>
<td>Reports the packets sent from the processor to the Ethernet links on the specified SFP port</td>
</tr>
</tbody>
</table>

**Figure 17.19 Diagnostics — Video Output Stream**
Technical Specifications

This chapter provides technical information for RAPTOR-IPG. Note that specifications are subject to change without notice.

SFP Single Mode Connections

Transmitter Port

Table 18.1 Technical Specifications — Single Mode Transmitter Port

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Ports</td>
<td>2</td>
</tr>
<tr>
<td>Data Rate</td>
<td>10Gbps</td>
</tr>
<tr>
<td>Center Wavelength (typical)</td>
<td>1310nm</td>
</tr>
<tr>
<td>OMA Output Power (min.)</td>
<td>-5.2dBm</td>
</tr>
<tr>
<td>Extinction Ratio (min.)</td>
<td>3.5dB</td>
</tr>
<tr>
<td>Side Mode Suppression Ratio - SMSR (min.)</td>
<td>30dB</td>
</tr>
<tr>
<td>Optical Return Loss</td>
<td>12dB</td>
</tr>
<tr>
<td>Link Length (max.)</td>
<td>10km</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Single-mode fiber</td>
</tr>
<tr>
<td></td>
<td>Standard LC duplex fiber-optic connector</td>
</tr>
</tbody>
</table>

Receiver Port

Table 18.2 Technical Specifications — Single Mode Receiver Port

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Ports</td>
<td>2</td>
</tr>
<tr>
<td>Signaling Speed</td>
<td>10Gbps</td>
</tr>
<tr>
<td>Center Wavelength</td>
<td>1310nm</td>
</tr>
<tr>
<td>Overload (min.)</td>
<td>0.5dBm</td>
</tr>
<tr>
<td>Receiver Sensitivity in OMA (max.)</td>
<td>-12.6dBm</td>
</tr>
<tr>
<td>Stressed Receive Sensitivity OMA (max.)</td>
<td>-10.3dBm</td>
</tr>
<tr>
<td>Link Length (max.)</td>
<td>10km</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Single-mode fiber</td>
</tr>
<tr>
<td></td>
<td>Standard LC duplex fiber-optic connector</td>
</tr>
</tbody>
</table>
SFP Multi-mode Connections

Transmitter

Table 18.3 Technical Specifications — Multi-mode Transmitter Port

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Ports</td>
<td>2</td>
</tr>
<tr>
<td>Data Rate</td>
<td>10Gbps</td>
</tr>
<tr>
<td>Signaling Speed Variation from Normal</td>
<td>+/-100ppm</td>
</tr>
<tr>
<td>Center Wavelength (typical)</td>
<td>850nm</td>
</tr>
<tr>
<td>Spectral Width RMS (max.)</td>
<td>0.65nm</td>
</tr>
<tr>
<td>Average Output Power (min.)</td>
<td>-5dBm</td>
</tr>
<tr>
<td>Extinction Ratio (min.)</td>
<td>3</td>
</tr>
<tr>
<td>Optical Return Loss</td>
<td>12dB</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Standard LC duplex fiber-optic connector</td>
</tr>
</tbody>
</table>

Receiver

Table 18.4 Technical Specifications — Multi-mode Receiver Port

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Ports</td>
<td>2</td>
</tr>
<tr>
<td>Signaling Speed</td>
<td>10Gbps</td>
</tr>
<tr>
<td>Signaling Speed Variation from Nominal</td>
<td>+/-100ppm</td>
</tr>
<tr>
<td>Center Wavelength</td>
<td>850nm</td>
</tr>
<tr>
<td>Overload (min.)</td>
<td>0dBm</td>
</tr>
<tr>
<td>Receiver Sensitivity in OMA (max.)</td>
<td>-11dBm</td>
</tr>
<tr>
<td>Stressed Receive Sensitivity OMA (max.)</td>
<td>-7.5dBm</td>
</tr>
<tr>
<td>Connector Type</td>
<td>Standard LC duplex fiber-optic connector</td>
</tr>
</tbody>
</table>

Multi-mode Fiber Link Length

Table 18.5 Multi-mode Fiber Link Length

<table>
<thead>
<tr>
<th>Fiber Type</th>
<th>Category</th>
<th>Minimum Modal Bandwidth @ 850nm (MHz*km)</th>
<th>Operating Range (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>62.5um MMF</td>
<td>FDDI</td>
<td>160</td>
<td>2-26</td>
</tr>
<tr>
<td></td>
<td>OM1</td>
<td>200</td>
<td>2-33</td>
</tr>
<tr>
<td>50um MMF</td>
<td>OM2</td>
<td>500</td>
<td>2-83</td>
</tr>
<tr>
<td></td>
<td>OM3</td>
<td>2000</td>
<td>2-300</td>
</tr>
</tbody>
</table>
SDI Inputs

Table 18.6  Technical Specifications — SDI Inputs

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Inputs</td>
<td>6</td>
</tr>
<tr>
<td>Standards Accommodated</td>
<td>1.485Gbps Component, SMPTE 292M</td>
</tr>
<tr>
<td></td>
<td>2.97Gbps Component, SMPTE 424M</td>
</tr>
<tr>
<td>Impedance</td>
<td>75ohm</td>
</tr>
<tr>
<td>Return Loss</td>
<td>&gt;15dB to 1.485Gbps</td>
</tr>
<tr>
<td></td>
<td>&gt;10dB to 2.97Gbps</td>
</tr>
<tr>
<td>Equalization (Belden 1694A cable)</td>
<td>&gt;240m (787ft) @ 1.485Gbps</td>
</tr>
<tr>
<td></td>
<td>&gt;180m (490ft) @ 2.97Gbps</td>
</tr>
<tr>
<td>Connection</td>
<td>HD-BNC</td>
</tr>
</tbody>
</table>

SDI Outputs

Table 18.7  Technical Specifications — SDI Outputs

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Outputs</td>
<td>6</td>
</tr>
<tr>
<td>Impedance</td>
<td>75ohm</td>
</tr>
<tr>
<td>Return Loss</td>
<td>&gt;15dB to 1.485Gbps</td>
</tr>
<tr>
<td></td>
<td>&gt;10dB to 2.97Gbps</td>
</tr>
<tr>
<td>Signal Level</td>
<td>800mV ±10%</td>
</tr>
<tr>
<td>DC Offset</td>
<td>0V ±50mV</td>
</tr>
<tr>
<td>Rise and Fall Time (20-80%)</td>
<td>1.485Gbps: &lt;270ps, &lt;100ps difference</td>
</tr>
<tr>
<td></td>
<td>2.97Gbps: &lt;135ps, &lt;50ps difference</td>
</tr>
<tr>
<td>Jitter</td>
<td>1.485Gbps: &lt;1.0UI jitter measured 10Hz-100kHz, &lt;0.2UI above 100kHz</td>
</tr>
<tr>
<td></td>
<td>2.97Gbps: &lt;1.0UI jitter measured 10Hz-100kHz, &lt;0.3UI above 100kHz</td>
</tr>
<tr>
<td>Overshoot</td>
<td>&lt;10%</td>
</tr>
<tr>
<td>Connection</td>
<td>HD-BNC</td>
</tr>
</tbody>
</table>

Environment

Table 18.8  Technical Specifications — Environment

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Ambient Temperature</td>
<td>40°C (104°F)</td>
</tr>
</tbody>
</table>

Power

Table 18.9  Technical Specifications — Power

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Power Consumption</td>
<td>40W-80W (application dependent)</td>
</tr>
</tbody>
</table>
Service Information

Routine maintenance to this openGear product is not required. In the event of problems with your RAPTOR-IPG card, the following basic troubleshooting checklist may help identify the source of the problem. If the card still does not appear to be working properly after checking all possible causes, please contact your openGear products distributor, or the Technical Support department at the numbers listed under the “Contacting Technical Support” on page 12.

1. Visual Review — Performing a quick visual check may reveal many problems, such as connectors not properly seated or loose cables. Check the card, the frame, and any associated peripheral equipment for signs of trouble.

2. Power Check — Verify the power indicator LED on the openGear frame front panel for the presence of power. If the power LED is not illuminated, verify that the power cable is connected to a power source and that power is available at the power main. Confirm that the power supplies are fully seated in their slots. If the power LED is still not illuminated, replace the power supply with one that is verified to work.

3. Reference Signal Status — Verify that the reference (blackburst or tri-level) is supplied on one of the available reference inputs. Check the Reference Status field in DashBoard.

4. Input Signal Status — Verify that source equipment is operating correctly and that a valid signal is being supplied.

5. Output Signal Path — Verify that destination equipment is operating correctly and receiving a valid signal.

6. Unit Exchange — Exchanging a suspect unit with a unit that is known to be working correctly is an efficient method for localizing problems to individual units.

Warranty and Repair Policy

The RAPTOR-IPG card is warranted to be free of any defect with respect to performance, quality, reliability, and workmanship for a period of FIVE (5) years from the date of shipment from our factory. In the event that your RAPTOR-IPG card proves to be defective in any way during this warranty period, Ross Video Limited reserves the right to repair or replace this piece of equipment with a unit of equal or superior performance characteristics.

Should you find that this RAPTOR-IPG card has failed after your warranty period has expired, we will repair your defective product should suitable replacement components be available. You, the owner, will bear any labor and/or part costs incurred in the repair or refurbishment of said equipment beyond the FIVE (5) year warranty period. In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profits) incurred by the use of this product. Implied warranties are expressly limited to the duration of this warranty.

This user manual provides all pertinent information for the safe installation and operation of your openGear Product. Ross Video policy dictates that all repairs to the RAPTOR-IPG card are to be conducted only by an authorized Ross Video Limited factory representative. Therefore, any unauthorized attempt to repair this product, by anyone other than an authorized Ross Video Limited factory representative, will automatically void the warranty. Please contact Ross Video Technical Support for more information.

In Case of Problems

Should any problem arise with your RAPTOR-IPG card, please contact the Ross Video Technical Support Department. (Contact information is supplied at the end of this publication.)

A Return Material Authorization number (RMA) will be issued to you, as well as specific shipping instructions, should you wish our factory to repair your RAPTOR-IPG card. If required, a temporary replacement frame will be made available at a nominal charge. Any shipping costs incurred will be the responsibility of you, the customer. All products shipped to you from Ross Video Limited will be shipped collect.

The Ross Video Technical Support Department will continue to provide advice on any product manufactured by Ross Video Limited, beyond the warranty period without charge, for the life of the equipment.
Software Licenses

This chapter provides third-party software license information for your RAPTOR-IPG. This product includes multiple software components which are individually licensed under one or more of the following licenses included in this chapter.

BSD

Copyright (c) 1991,1993, The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by Kenneth Almquist.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Dual GPL

Portions of this software are copyright (C) 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

This project is also covered under the GPL v2.

GPL

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is fundamentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If
such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

"This License" refers to version 3 of the GNU General Public License.

"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or organizations.

To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available to the public, and in some countries other activities as well.

To "convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, with no transfer of a copy, is not conveying.

An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list meets this criterion.


The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.

A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a particular programming language, one that is widely used among developers working in that language.

The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, window system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code interpreter used to run it.

The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocably provided the stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.

You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-protective terms added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided that you also meet all of these conditions:

a. The work must carry prominent notices stating that you modified it, and giving a relevant date.

b. The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the requirement in section 4 to "keep intact all notices".

c. You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source under the terms of this License, in one of these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the Corresponding Source from a network server at no charge.

c. Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

d. Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.

e. Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the object code work.

A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product received by a particular user, "normally used" refers to a typical or common use of that class of product, regardless of the status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License without regard to the additional permissions.
When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supplement the terms of this License with terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
b. Requiring preservation of specified reasonable legal notices or author attributions in that material and in the Appropriate Legal Notices displayed by works containing it; or
c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from the original version; or
d. Limiting the use for publicity purposes of names of licensors or authors of the material; or
e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f. Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.


You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this License.

An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called the contributor's "contributor version".

A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a consequence of further modification of the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a manner consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under applicable patent law.


If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.


The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the object code with a copy of the GNU GPL and this license document.


You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the Combined Work with a copy of the GNU GPL and this license document.

c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL and this license document.

d. Do one of the following:

1) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the Linked Version.

e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.)


You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:
6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

MIT

Copyright 1987, 1988 by MIT Student Information Processing Board.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.I.T. and the M.I.T. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T. S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

zlib

Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler jloap@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
Glossary

The following terms are used throughout this guide:

**Active image** — the portion of the video picture area (production aperture) that is being utilized for output content. Active image excludes letterbox bars and pillarbox bars.

**BMCA** — Best Master Clock Algorithm

**Card** — openGear terminal devices within openGear frames, including all components and switches.

**CBR** — constant bit rate.

**CDN** — content distribution network.

**DashBoard** — the DashBoard Control System.

**Device** — a physical, virtual, or software application that may include multiple sources, destinations, senders, or receivers.

**Essence** — a single elementary logical media signal. For example, a video essence is one video channel. An audio essence is a single audio (mono) channel.

**DF** — Differentiated Services.

**DTVCC captions** — CEA-708 captions.

**Flow** — the continuous raw media content. It can contain more than one essence (e.g. an audio flow can contain multiple channels, and an SDI flow may contain audio and video essences).

**Frame** — the openGear frame that houses the RAPTOR-IPG.

**HLS** — HTTP Live streaming.

**HTTP** — Direct Hypertext Transfer Protocol.

**MIB** — management information base.

**Network Controller Card** — the MFC-8322-N or MFC-OG3-N and any available options unless otherwise noted.

**NTSC captions** — the CEA-608-D: Line 21 Data Services captions.

**openGear frame** — refers to the OGX-FR series frames unless otherwise noted.

**PAL** — PAL-B and PAL-G unless otherwise stated.

**PCR** — program clock reference.

**PID** — packet identifier.

**Receiver** — an element within a device which that receives one stream, which contains one flow from a network.

**RTMP** — Real Time Messaging Protocol.

**Sender** — an element within a device which presents exactly one flow, packaged as a stream onto a network.

**Stream** — one flow, encapsulated within a transport protocol.

**System** — the mix of interconnected production and terminal equipment in your environment.

**TCP** — Transmission Control Protocol.

**TOS** — Type of Service.

**TPG** — Test Packet Generator.

**TTL** — Time To Live.

**UDP** — User Datagram Protocol.